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Copyrights and Trademarks

©2007, Tyco Safety Products Westminster, MA 01441-0001 USA.  All rights reserved. Simplex
and the Simplex logo are registered trademarks of Tyco International Ltd. and its affiliates and are
used under license. Printed in the United States of America.

Information in this document is subject to change without notice. No part of this document may be
reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose,
without the express written consent of Tyco Safety Products Westminster.

Cautions and Warnings

SYSTEM REACCEPTANCE TEST AFTER SOFTWARE CHANGES - To ensure proper sys-
tem operation, this product must be tested in accordance with NFPA-72, after any programming
operation or change in site-specific software. Reacceptance testing is required after any change,
addition or deletion of system components, or after any modification, repair or adjustment to sys-
tem hardware or wiring.

All components, circuits, system operations, or software functions known to be affected by a
change must be 100% tested. In addition, to ensure that other operations are not inadvertently
affected, at least 10% of initiating devices that are not directly affected by the change, up to a max-
imum of 50 devices, must also be tested and proper system operation verified.

Follow the instructions in the installation, operating and programming manuals. These instructions
must be followed to avoid damage to the control panel and associated equipment. FACP operation
and reliability depend upon proper installation.
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Conventions Used The following conventions are used in this publication to identify special names or text.

• When a membrane panel key (located below the display) is referenced in this manual, it is nor-
mally shown between left and right arrows.  Examples are <ALARM SILENCE> and <SYS-
TEM RESET>.

• Italic type indicates important terms or titles of publications.
• Text enclosed in quotation marks indicates the title of a chapter or section of the manual, such 

as “How to Use this Publication.”
• Bulleted lists, such as this one, provide you with information. They are also used to indicate 

alternatives in numbered procedural steps.
• Numbered lists indicate procedures with steps that you must carry out sequentially.

Keyboard 
Conventions

The following conventions are used to describe keys and key combinations.

• Key names appear in bold type and in capital letters and are referred to by their names only, 
without the word "key."  For example, "press SHIFT" means press the keyboard key labeled 
"Shift."

• A plus sign (+) between two key names means that you hold down the first key while pressing 
the second key.  For example, "press SHIFT+F1" means hold down the SHIFT key while 
pressing the F1 key.  If the key sequence includes three or more key names, hold down all of 
the keys except for the last one, and then press and release the last key.  For example, "press 
CTRL+ALT+DEL" means hold down the CTRL and ALT keys, and then press the DEL key.

• A comma between key names means that you press and release the first key, and than press and 
release the second key, and so on.  For example, "press ALT, F, P" means press ALT and 
release it, press F and release it, and press P and release it.

• Arrow keys is the collective name for the UP ARROW, DOWN ARROW, LEFT ARROW, and 
RIGHT ARROW keys.

Text Conventions The following conventions are used to describe text combinations.

• Specific text that you are to type is shown in bold.  What you type is always shown in lower-
case letters, unless it must be typed in UPPERCASE letters to work properly.

• Place holders for items such as filenames that you must supply yourself are shown in italic. 

How to Use this Publication
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How to Use this Publication (continued)

Using the Mouse The following table lists four common terms related to mouse operation that you should know
before using this Windows application.  Use the left mouse button for all actions unless instructed
otherwise.

TERM FUNCTION

Point Move the mouse until the tip of the mouse 
pointer rests on the screen object or area that 
you wish to point to. 

Click Point to the item you want to select and press 
and immediately release the mouse button 
without moving the mouse.

Double-click Point to the item you want to select and press 
and immediately release the mouse button 
twice in rapid succession without moving the 
mouse.

Drag Point to the item you want to move and press
and hold down the mouse button while you
move the mouse.  When you have moved the
mouse pointer to the position you want, release
the mouse button without moving the mouse.
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Chapter 1. Overview

Introduction The 4190 TrueSite Workstation (TSW) is a node on a 4120 Network.  It provides a graphical user 
interface used for annunciating and controlling the points contained within the network.  The 
graphical interface provided makes it easy to interact with the network by entering input through a 
keyboard, mouse, or touchscreen. The TSW can also be localized to operate in a different language.

This publication provides instructions for configuring the TSW.

Related 
Documentation

• Simplex TrueSite Workstation Installation and Checkout Instructions  . . . . . . . . . . . . . . . 579-834
• Worlwide Fire Workstation - Localization Procedure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 901-004
• Simplex TrueSite Workstation Operation and Application Instructions. . . . . . . . . . . . . . . 579-835
• 4190 TrueSite Workstation Software Upgrade Instructions . . . . . . . . . . . . . . . . . . . . . . . . 579-838
• Network Programmer Installation and Programming Instructions . . . . . . . . . . . . . . . . . . 579-166
• GCC Multi-Network Option . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 574-631
• Network Concepts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .NET-91-500
• 4120 Network Installation Instructions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .NET-21-004
• 4120 Programming. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .NET-41-003
• 4100+/4120/UT System Card Installation Instructions . . . . . . . . . . . . . . . . . . . . . . . . FA4-21-205

Requirements The TrueSite Workstation Configurator operates under Windows XP and is best viewed with a 
1024x768 screen resolution.

If you have a USB dongle key, plug it in a USB port and turn on the power to your computer.
If you have a 743-049 parallel port key, follow this procedure:
1. Turn off the power to your computer.
2. Remove your printer cable (if installed) from your parallel port (LPT1).  Connect the 743-049 

software key to your parallel port and reconnect your printer cable to the software key.
3. Turn on the power to your computer.

Caution:  MAKE SURE YOU USE ONLY ONE PC.  Do not attempt to split up the tasks and use more 
than one PC to configure the TSW.  Doing so can create problems for you later.
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Configuring Tasks Each of the following chapters present procedures that describe how to accomplish the various 
configuring tasks.

You will need to use the 4100U/4100/4020/4002 Programmer to create the nodes and declare the 
public points.

The Network Programmer is also required in a multiloop environment.

Localization For details on localizing the TSW, see Worlwide Fire Workstation - Localization Procedure 901-004; 
the user interface is also available in French at this time.

Topic Chapter #

Basic Operations 2

Configuration Features 3

Graphics Editor 4

Using the Utility, the Log On/Off and the Help Options 5
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Chapter 2. Basic Operations

Overview This chapter discusses the basic operations that you will perform on the TrueSite Workstation 
Configurator.

In this Chapter Refer to the page number listed in the following table for specific information on a topic.

Topic See Page #

Overview 2-1

Launching the TSW Configurator 2-2

Main Menu Options 2-3

Displaying the File Menu 2-4

Creating a Site/Network 2-4

Selecting a Site 2-5

Creating a Job 2-5

Opening an Existing Job 2-7

Logging On 2-8

Changing a Passcode 2-8

Saving the Job 2-9

Unloading the Job 2-10

Generating and Printing Reports 2-10

Exiting the Configurator 2-11
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Launching the TSW 
Configurator

There are two (2) TrueSite Workstation icons; one is for the runtime application and the second – 
depicted as a toolbox – is for the Configurator.

 Figure 2-1    TSW Application Icons

Double-click the TrueSite Workstation Configurator icon to start.

 Figure 2-2    TrueStation Workstation Configurator Main Menu

The Configurator Main Menu is where you gain access to the various options that are available for 
configuring the TSW.  The Configurator consists of a set of editors and utilities that allow you to 
create and modify TSW jobs.

At start-up, the Configurator appears as a blank window with a menu at the top and a status bar at the 
bottom.  The menu provides access to the various editors and utilities, and the status bar displays 
information about the current network, job, and edit status.
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Main Menu Options Figure 2-3 shows the options that are available through the Main Menu.

 Figure 2-3    Configurator Main Menu Options

These options are discussed in more detail in the paragraphs that follow.
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Displaying the File 
Menu

The File Menu allows you to work with job files and network files. When you click on File, the File 
menu is displayed. To edit a job, you must
1. specify the site or network (see Creating a Site/Network or Selecting a Site
2. create or open the job (see Creating a New Job or Opening an Existing Job)
3. log on (see Logging On).

 Figure 2-4    Configurator File Menu

Creating a Site/
Network

This allows you to create a site with the specified name, and also create a network with the same 
name. Note that this can also be done from the Network Programmer, where a site can be created with 
a different network name, and possibly more than one network.

When you click on Create Site/Network in the File menu, the Create Site/Network dialog is 
displayed.

 Figure 2-5    Create Site/Network Dialog
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Selecting a Site This allows you to change the currently selected site. All new jobs created in the Configurator will be 
placed under the currently selected site, and the job dialog will only list jobs placed under this site.

When you click on Select Site, the Select Site dialog is displayed.

 Figure 2-6    Select Site Dialog

Select the site by entering its filename.

Creating a Job The New option in the File menu allows you to create a new TSW job in the currently selected site.  
Click on New to create a new job. 

If there is no job currently loaded in the Configurator, selecting New immediately displays the Create 
Job dialog.

 Figure 2-7    Create Job Dialog

Note: The Configurator only creates jobs of type TSW.

If a job is already loaded in the Configurator, the dialog shown in Figure 2-8 is displayed.

 Figure 2-8    “Unload Job” Dialog

Unload the current job by clicking on the Unload button.  As soon as the current job is unloaded, the 
Create Job dialog (Figure 2-7) is displayed.
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Clicking OK on the Create Job dialog displays the General Information Data Entry dialog.

General Information Data Entry Dialog

The General Information Data Entry dialog allows you to record information about the job for 
documentation purposes.

 Figure 2-9    General Information Data Entry 

Enter the information in the fields (see the General Information section in chapter 3).

When you are finished entering the information, click on OK.  You are returned to the Main Menu 
where you can now log on to edit the job.
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Opening an 
Existing Job

The Open option in the File menu allows you to open an existing job on the current network.  IMS 
and GCC jobs are open and converted to TSW jobs; once the job is saved under TSW, it cannot revert 
to its previous system type.  Select Open to see the Job Directory window.

 Note 1.  IMS or GCC jobs must be at Revision 3.01 (or higher) in order to perform an upgrade into 
TSW. GCC jobs containing graphics must be upgraded/built in the IMS Programmer before 
upgrading to TSW.

Note 2.  If you already have a job loaded when you select Open, the Open Job dialog appears with 
a warning that you must first unload the current job.  Click on the Unload button.  After you 
click on Unload, the Job Directory window is displayed. 

 Figure 2-10    Job Directory Window

The Job Directory window displays the jobs currently available.  Select the job you want to open; 
then click on OK.  

The Configurator Main Menu is displayed with the Configure and Utility selections grayed out.  At 
this point, you must log on to activate the selections available at your access level.  (See Logging On 
below.)

The Configurator is now available for your configuring tasks.  Note that all of the Main Menu top 
menu bar selections are available and the job is identified at the bottom of the window.



2-8

Logging On Before you can edit a job, you must log on.  On the main menu, click Log On/Off; at the Log On 
Services window, you can also log off and log on at a different level or at the same level.

 Figure 2-11    Log On Services Dialog

Enter your Name/Number and Passcode and click on OK. The dialog will then display your 
operator name, operator number, and your access level, and most or all of the options on the Main 
Menu become active (according to your access level).  Click on OK a second time, and the Log On 
Services dialog closes, leaving the Main Menu available for configuring the job.

Changing a Passcode

To change a passcode, click the Chg Pass button on the Log On Services dialog and enter the 
required passcodes.

 Figure 2-12    Change Default Passcode Window
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Saving the Job Save Option

The Save option allows you to save the job you are currently editing to the hard drive.  When you 
click on Save, the Save Job dialog is displayed. 

 Figure 2-13    Save Job Dialog

To save the job, click on YES and the job is saved. 

Note: Saving this job will not change the Runtime job.  To make this job the new Runtime job, you 
must build the job with the Job Builder located in the Utilities menu.

Save As Option

The Save As dialog prompts you for both a New Node Name and a New Node Number.

 Figure 2-14    Save As Dialog

• Rename Node: lets you change the name and/or the number of the current node
• Make New Copy: lets you duplicate the current node with a different name and a different num-

ber
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Unloading the Job If you select the File Menu option Unload Job, the window shown in Figure 2-15 is displayed.

 Figure 2-15    Main Window with “No Job Loaded” Message

The message bar at the bottom of the window informs you that there is no job loaded in memory.

Generating and 
Printing Reports

When you click on Reports/Printer, the Report Selection Dialog is displayed. 

 Figure 2-16    Report Selection Dialog
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From this dialog, select the type of report to generate. 
• Default Report: shows all reports, sequentially
• Gen Info Report: shows the information from the Configure > General Information command
• Hardware Report: shows the information from the Configure > Hardware Config command
• Action Message Report: shows the information from the Configure > Action Message com-

mand
• Revision History Report: shows the information from the Configure > Revision History com-

mand
• Point Config Report: shows the information from the Configure > Point Config command
• Point List Report: shows all system lists (from L0 to L511) and user lists (L512 and up), both 

local and external, along with their contents
• Operator Report: shows the information from the Configure > Operator Definition command
• Access Level Report: shows the information from the Configure > Access Level command
• Options Report: shows the information from the Configure > System Options command
• Port Vectoring Report: shows the information from the Configure > Port Vectoring command
• Usage Report: shows a summary of the total points programmed in the point configuration, the 

total number of action messages, and the total disk space used
• Utility & Audio Control Report: shows the utility switch programming from the Configure > 

Utility Screens command, the audio control switch programming from the Configure > Audio 
Screens command, and the information from the Configure > Audio Options command

• 2120 Point Mapping Report: shows a cross-reference report of all 2120 SLI points programmed 
into the job, including the 2120 point name and the TSW point name for each point

• 2120 Port Usage Report: shows the 2120 file number and the timestamp for each 2120 SLI port 
configured on the job

Select the printing Target before you click the Generate button.

When you click on the Target button, a list of available Windows-defined printers is displayed for 
selection.

Exiting the 
Configurator

When you click on Exit, you exit out of the Configurator.  If you have made changes, you are 
prompted to save the changes.
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Chapter 3. Configuration Features

Introduction This chapter describes the various configuration features.

In this Chapter Refer to the page number listed in the following table for specific information on a topic.

Topic See Page #

Introduction 3-1

Starting the Configuration Process 3-2

Using the Point Configuration Editor 3-3

Using the Action Message Editor 3-10

Configuring System Hardware 3-16

Port/Event Vectoring 3-20

Configuring Audio Options/Audio Screens 3-21

Defining Utility Control Screens 3-23

Using the Control Screen Editor 3-26

System Options 3-29

 System Options - Preferences 3-30

System Options - Operations 3-32

Color Definition 3-35

General Information 3-36

Revision History 3-38

Setting Up Access Levels 3-39

Setting Up Access Levels - Runtime Access Level 3-40

Setting Up Access Levels - Configurator Access Level 3-42

Operator Definition 3-43

Registry Configuration 3-44
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The Configure 
Menu

The Configure Menu allows you to configure both the system hardware and system operations.  Go to 
the Configurator Menu Bar at the top of the Main Screen and click on Configure.  The Configure 
Menu is displayed. 

 Figure 3-1    Configure Menu

Starting the Configuration Process
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Editing Points When you click on Point Config from the Configure menu, a screen similar to the one shown in 
Figure 3-2 is displayed.

 Figure 3-2    Point Configuration Screen

The Point Configuration Editor allows an operator, with proper access levels, to add, delete, and 
modify points.

The top level of the editor consists of a window with a button bar, menu, and spreadsheet.  The button 
bar and menu invoke various editor functions.  The spreadsheet displays point numbers, point class, 
point name, device type, point type, and custom label.  The operator moves a marker or highlight 
around the spreadsheet, using mouse or keyboard, to select particular points and data fields.  Selecting 
menu and button bar elements, or pressing special keyboard keys, performs actions on the points.  
These actions may occur immediately or create dialogs prompting for further choices or actions.

The ability to perform these actions depends upon the operator’s access level, and the editor 
environment.  If a function is not allowed, the menu element or button is grayed out.  Disallowed 
keyboard functions cause the keyboard action to be ignored.  Some disabled functions present a 
dialog box to explain why an action was refused.

The actions may act on the entire database and editor, change the editor environment, or act upon one 
or more points.  The keyboard and mouse are used to move about the points, select particular points, 
and invoke various point modification dialogs.

Using the Point Configuration Editor
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Text Editing The ability to edit text in point labels is controlled by the operator’s access level and how the system 
was configured.  The operator edits point labels by moving the highlight to the label field.  If an 
operator can edit text, the text field will have a movable blinking caret or vertical line in it.  If the 
operator does not have this privilege, the caret cannot be moved.  Custom labels can only be changed 
for points owned by the TSW.

Text is entered or deleted at the caret location.  The caret can be moved with horizontal cursor keys or 
moved elsewhere with a mouse click.  Control-cursor keys will move the caret from word to word.  
Control END and Control HOME will move the cursor to either the beginning or end of text.  By 
holding the left mouse key down, clicking between two characters, and sweeping the mouse across 
the characters, a range is ‘selected’.  In the label field, the selection is black text, and a white 
background.  Hitting the delete key on the KEYBOARD, or entering new text will delete this range.

Navigation The HOME, END, PAGE UP, PAGE DOWN, TAB, BACK TAB, cursor keys, and mouse move a 
marker from point to point and field to field.  They also scroll the spreadsheet to new point display 
areas.  

Clicking the left mouse button over a data field moves the highlight or marker to that point and field.  

Cursor keys move the marker one field at a time in the direction indicated by the cursor key.  

The TAB and BACK TAB (shift-TAB) move the highlight right or left, and wrap the marker to a new 
line when a horizontal edge is encountered.

The HOME, END, PAGE UP, and PAGE DOWN keys perform marker moves.  The HOME and 
END keys move the marker to the top or bottom of the current display.  Once the marker is here, 
further use of the key moves the marker to the very beginning or end of all points.

The operator can also change the points displayed with the use of the scroll bar on the right side of 
the spreadsheet.  The scroll bar only appears when the number of points no longer fit on one screen.  
The operator can shift focus from the spreadsheet to the button bar by pressing the control-up arrow 
combination.  Once focus is in the button bar the left/right cursor keys, and tab/shift  tab move focus 
among the buttons.  The operator can return focus to the spreadsheet by pressing the control-down 
arrow combination.  Pressing <ENTER> or <SPACE> will perform the equivalent of a button press 
on the focused button.  Note that button bar functions can also be reached from the spreadsheet by 
using the button’s accelerator key.  This key is the ALT-<character> combination.  The character is 
marked in the button bar with an underline.  Most editor operations will return focus to the 
spreadsheet, when they are done.

Special Keys (Non-
Navigational)

The F1 key will bring up general Configurator help (unlike the menu Help, which brings up point 
configuration editor help).  

The F2 key may open special editors, if the current data field and point type supports an editor, and if 
the operator access level is sufficient.  

The F5 key will open the MORE INFO dialog for the highlighted point.  

Pressing the space bar when the highlight is over a point (and NOT over the label) toggles a flag in 
the point number field.  This marks the point as ready to be acted upon by a group action, such as 
DELETE.

Note that double clicking with the mouse over the fields with a special editor produces the same result 
as the F2 key, and double clicking over the point number field toggles the tag.  

Using the Point Configuration Editor (continued)
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Tagging Points may be tagged so actions can be performed on a group.  Tagging causes a flag to appear in the 
point number field.  A point is tagged by double clicking the mouse over the point number field, or by 
pressing the space bar while the highlight is over any field but the label field.  Performing this over an 
already tagged point removes the tag.

Menus and Button 
Bar Functions

Save: Button Bar and Menu (under File Menu Option)

This option saves all changes to the point configuration screen; the changes are not committed to the 
job database until a save operation is performed.  

Note: The save option only saves the editor session.  If any changes are to be permanent, the JOB 
must be saved to the hard drive from the main Configurator screen.

Exit: Button Bar and Menu (under File Menu Option)

The menu option allows an operator to exit an editing session.  The option will prompt the operator to 
save changes, if any have occurred.

Add: Button Bar and Menu (under Edit Menu Option) 

When you select Add, the screen shown in Figure 3-3 is displayed.

 Figure 3-3    Add Point Window

Custom user points should be added to the points database starting at position 2816.  Previous address 
locations are reserved for system points.  To add points, the operator must have the proper access 
level.  This option brings up a Select Category dialog, from which the operator selects a DIGITAL, 
ANALOG, LIST, EXTERNAL or 2120 BMUX or DACR category. 

The DIGITAL, ANALOG, and LIST selections bring up a dialog which allows the operator to specify 
the number of points to be added, and to supply a preliminary label.  The DlGITAL and ANALOG 
types allow a preliminary  point type to be selected.  This can be modified later.  The screens for 
specifying Digital Point Information and Analog Point Information are shown in Figure 3-4 and 
Figure 3-5.

Using the Point Configuration Editor (continued)
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 Figure 3-4    Specify Digital Point Information Box

 Figure 3-5    Specify Analog Point Information Box

The LIST type is initially empty, and points can be added to the list or deleted by double clicking on 
the point type field after the list is added.  This brings up a tag list dialog.  A list is limited to 4096 
entries.  Figure 3-6 shows the Specify List Point Information Box.

 Figure 3-6    Specify List Point Information Box

Using the Point Configuration Editor (continued)
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The EXTERNAL category brings up a node selection dialog, consisting of a list box of other nodes, 
and a Select and Exit button (Figure 3-7).

 Figure 3-7    External Nodes Selection Box

Pressing Select brings up a tag list of public points from the node highlighted in the list box.

These points are exported by tagging them, and hitting OK in the tag list.  The tag list Cancel button 
exits with no changes.

Note: The editor only allows you to add as many points as can fit between the current marker 
position and the next used point number.

The 2120 BMUX button allows you to configure the settings for 2120 BMUX and to add the points. 
2120 BMUX is defined with the Hardware Configuration feature. For more information, see 
Appendix C - Configuring a Quad Serial Port Card.

The DACR button allows you to configure the settings for DACR and to add the points. The DACR 
port is defined with the Hardware Configuration feature; for more information, see Appendix D - 
Configuring a DACR Port.

Delete: Button Bar and Menu (under Edit Menu Option) 

This action deletes a series of tagged points or deletes the point at the marker location.  This action 
requires that the operator have DELETE privileges.

Using the Point Configuration Editor (continued)
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View: Button Bar and Menu 

This brings up a screen (Figure 3-8) with which the operator may change the filtering of point classes 
and ranges viewed.  The operator can filter points on device class, point range, and owner class.

 Figure 3-8    Set Point Database View

Goto: Button Bar and Menu (under Edit Menu Option) 

Brings up a window (Figure 3-9 which requests which point to set the display to show.

 Figure 3-9    Go To Selected Offset Window

Note: If the desired point is not in the current view, the view filter will be updated to include the 
desired point.  For example, if the current view only includes system points, and the operator 
enters an point number in the user range, the view will be updated to include user points, and 
the spreadsheet will jump to the given point row.

Action Message: Button Bar and Menu (under Edit Menu Option) 

This option brings up a window (Figure 3-10) with a list box and several buttons.

 Figure 3-10    Message Mapping Window

Using the Point Configuration Editor (continued)
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The list box displays the valid states for the point, and which message is mapped to that state for the 
point.  The buttons allow the operator to save or cancel any changed mappings and exit the dialog, or 
change mappings and view the mapped message.

The Assign button will bring up a further dialog, centered on the highlighted state.  This new dialog 
consists of a drop down list box and buttons.  The drop down list box shows the currently selected 
message for this state, and allows the operator to select a new message.  The buttons allow the 
operator to save any changes and exit the assignment dialog, cancel any changes and exit the dialog, 
or just view the contents of a message.

More Info: Button Bar

Brings up a window (Figure 3-11) which displays detailed point information.

 Figure 3-11    More Information Window

Toggle: Button Bar and Menu (under Edit Menu Option) 

Changes Public points to Local, and Local Points to Public.  This acts on tagged points, or if no points 
are tagged, upon the point where the marker currently resides.

Tag All: Menu (under Edit Menu Option)

This option tags all the points in the current view.  The tagged points can then have group actions, 
such as Toggle, applied to them.  The action will clear the tags from the selected points.  

Clear Tags: Menu (under Edit Menu Option)

This option clears all the tags from the points.

Individual points can have a tag toggled on and off by pressing the space bar while the highlight is 
anywhere but the Custom Label Field.  Double clicking the mouse in the point number column will 
also toggle the tagging state of the point.

Help: Menu

The Help button brings up a dialog with information on how to use the point editor, and explains 
creating, copying, deleting, and modifying points.

Using the Point Configuration Editor (continued)
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About the Action 
Message Editor

When you click on Action Message from the Configure menu, a screen similar to the one shown in 
Figure 3-12 is displayed.

 Figure 3-12    Action Message Editor Screen

The Action Message Editor allows you to create, modify, and delete messages if you have the 
required access level. Action messages can be used in configuring point groups; see the information 
on ACK options under the System Options section.

A message can consist of up to a 40 character label field and up to a 25,000 character message field.  
You can use a message to provide details about a particular point event or to suggest actions to be 
taken in response to an event.  The messages can be assigned to particular point events with the action 
message mapper found in the point configuration editor or by selecting the Edit Menu item and then 
Point Assignment.

The top level of the editor consists of a window with a button bar, menu, and spreadsheet.  The button 
bar and menu invoke various editor functions.  The spreadsheet displays message numbers, message 
class, custom label, and reference count information.  You move a marker or highlight around the 
spreadsheet, using mouse and keyboard, to select particular messages and data fields.  Selecting menu 
and button bar elements, or pressing special keyboard keys, performs actions upon the messages.  
These actions may occur immediately, or create dialogs prompting further choices and actions.  One 
of these dialogs is the actual text editor, which allows an operator to create and modify message text.

The menu, button bar, and special keys perform various editor functions.  The ability to perform these 
actions depends upon the operator's access level, and the editor environment.  If a function is not 
allowed, the menu element or button is grayed out.  Disallowed keyboard functions cause the 
keyboard action to be ignored.  Some disabled functions present a dialog box to explain why an action 
was refused.  The actions may act on the entire database and editor, change the editor environment, or 
act upon one or more messages.

Using the Action Message Editor
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The keyboard and mouse are used to move through the messages, select particular messages, invoke 
the actual text editor, and edit the text.

The HOME, END, PAGE UP, PAGE DOWN, TAB, BACK TAB, cursor keys, and mouse move a 
marker from message to message and field to field.  They also scroll the spreadsheet to new message 
display areas.

Clicking the left mouse button over a data field will move the highlight or marker, to that message 
and data field.

Cursor keys move the marker one field at a time in the direction indicated by the cursor key.

The TAB and BACK TAB (shift-TAB) move the highlight right or left, and wrap the marker to a new 
line when an edge is encountered.

The HOME, END, PAGE UP, and PAGE DOWN keys perform marker moves.  The HOME and 
END keys move the marker to the top or bottom of the current display.  Once the marker is here, 
further use of the key moves the marker to the very beginning or end of all messages.

The operator can also change the message range displayed with the use of the scroll bar on the right 
side of the spreadsheet.  The scroll bar only appears when the number of messages no longer fit on 
one screen.

The operator can shift focus from the spreadsheet to the button bar by pressing the control-up arrow 
combination.  Once focus is in the button bar the left/right cursor keys, and tab/shift tab move focus 
among the buttons.  The operator can return focus to the spreadsheet by pressing the control-down 
arrow combination.  Pressing <ENTER> or <SPACE> will perform the equivalent of a button press 
on the focused button.  Note that button bar functions can also be reached from the spreadsheet by 
using the button's accelerator key.  This key is the ALT-<character> combination.  The character is 
marked in the button bar with an underline.  Most editor operations will return focus to the 
spreadsheet, when they are done.

In addition, the functions of three keys are mentioned here.
• The F1 key will bring up general Configurator help (unlike the menu Help, which brings up 

Action Message editor help).
• The F2 key opens the text editor or text browser, depending on operator access levels if the 

highlight is over a message.
• Pressing the space bar when the highlight is over a message (and NOT over the label) tog-

gles a flag in the message number field.  This marks the message as ready to be acted upon 
by a group action, such as DELETE.

Note that double clicking with the mouse over the label field will produce the same result as the F2 
key, and double clicking over the message number field will toggle the tag.

Messages may be tagged so actions can be performed on a group.  Tagging causes a flag to appear in 
the message number field.  A message is tagged by double clicking the mouse over the message 
number field, or by pressing the space bar while the highlight is over any field but the label field.  
Performing this over an already tagged message removes the tag.  The Clear button in the button bar 
will remove ALL tags.  Changing the view while items are tagged will cause a dialog warning that 
tags will be cleared.  The dialog allows you to cancel the view change, and preserve the current 
tagging.

Using the Action Message Editor (continued)
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Menu and Button 
Bar Functions

Save: Button Bar and Menu  (under File Menu Option)

The Save button, and the Save option under the File Menu simply saves all changes and allow the 
operator to remain in the action message editor.  It is important to note that saving changes from either 
the button or menu option only saves the editor session.  If any changes are to be permanent, the JOB 
must be saved from the main Configurator screen.

Exit: Button Bar and Menu  (under File Menu Option)

The Exit button, and the Exit option under the File Menu allows an operator to exit the editor.  The 
exit option will prompt the operator to save changes, if any have occurred.  It is important to note that 
saving changes only saves the editor session.  If any changes are to be permanent, the JOB must be 
saved from the main Configurator screen.

Add: Button Bar and Menu  (under Edit Menu Option)

The add action allows the operator to add new messages to the action message database.  The Add 
action is available from the button bar, or from the Add option under the Edit menu.  To add 
messages, the operator must have sufficient access level privileges, have the editor view include 
UNUSED and the target message class “LOCAL”.  Otherwise, the button and menu item are 
disabled.  The operator must also have the marker on an unused message number in the local message 
range, which starts at position 512.

Note: Action messages prior to position 512 are system action messages, and the operator is not 
allowed to add messages within this range. 

The editor brings up a dialog requesting the number of messages and a preliminary label.  Hitting OK 
creates these messages, and returns the operator to the editor.  Only local messages can be created.

Note that the editor will only allow you to add as many messages as will fit between the current 
marker position and the next used message number. The messages are created empty, and must have 
text added with the text editor.

Site Messages can be found at Message Number 100 through Message Number 105.  If a site 
message contains text, it will be accessible in the run time, through a button in the site info window.  
The site message label will appear there as the button text.

Copy: Button Bar and Menu (under Edit Menu Option)

The Copy action is available from the button bar, or from the Copy option under the Edit menu.  The 
Copy action makes a copy of tagged messages to the current marker location.  This action requires 
that the operator have ADD privileges, messages be tagged, the view include UNUSED, the marker 
must be on an unused message number, and the number of tagged messages must not exceed the 
number of unused message numbers at the current marker location.  The new copies contain the same 
label and text information as the original messages.  

Delete: Button Bar and Menu (under Edit Menu Option)

The Delete action is available from the button bar, or from the Delete option under the Edit menu.  
This action deletes a series of tagged messages or deletes the message at the marker location.  This 
action requires that the operator have DELETE privileges.  System messages can not be deleted.
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View: Button Bar and Menu  

The View action is available from the button bar, or from the View menu.  This action changes the 
filtering of which message classes are viewed.  Note that UNUSED must be selected for functions 
like Copy and Add to be enabled.  Figure 3-13 shows the View Messages Window.

 Figure 3-13    View Messages Window

Goto: Button Bar and Menu  (under Edit Menu Option)

The Goto action is available from the button bar, or from the Goto option under the Edit menu.  The 
function allows you to enter an action message number to go to.  Figure 3-14 shows the Goto Msg 
Window.

 Figure 3-14    Goto Messages Window

Note: NOTE: If the desired action message is not in the current view, the view filter will be updated 
to include the desired message.  For example, if the current view only includes local 
messages, and the operator enters an action message number in the system range, the view 
will be updated to include system messages, and the spreadsheet will jump to the given 
message row.

Clear: Button Bar   

The Clear action is only available from the button bar.  It is normally grayed out, but becomes enabled 
when any messages have been tagged.  It clears tags from any tagged messages.

Help: Button Bar   

The Help button brings up a dialog with information on how to use the message editor, and explains 
creating, copying, deleting, and modifying messages.
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Editing Messages 
and Label Text

The ability to edit text in labels and messages is controlled by the operator's access level and how the 
system was configured.  If an operator can edit text, the text field will have a movable blinking caret 
or vertical line in it.  If the operator does not have this privilege, the caret can not be moved.

Text is entered or deleted at the caret location.  The caret can be moved with horizontal cursor keys or 
moved elsewhere with a mouse click.  Control-cursor keys will move the caret from word to word.  
Control END and Control HOME will move the cursor to either the beginning or end of text.  By 
holding the left mouse key down, clicking between two characters, and sweeping the mouse across 
the characters, a range is selected.  In the label field, the selection is black text, and a white 
background.  In the text editor, it is white text and a black background.  Hitting the delete key on the 
KEYBOARD, or entering new text will delete this range.

The operator edits message labels by moving the highlight to the label field.  To edit the message 
itself, the operator moves the highlight to the label field, and either presses the F2 key, or double 
clicks over the field.  This will bring up the text editor, if the access levels allow, or only the browser, 
if access levels prohibit it.  The editor has both OK and CANCEL buttons, while the browser only has 
an OK button.

Export/Import of 
Action Messages

To export a message, tag it (using the space bar) and then click on File.  When you click on Export, 
you are prompted to specify the export filename.

 Figure 3-15    Export Action Message Dialog 
(Prompting for the Export Filename)

Messages are exported in a text editable file that is stored on the network directory at NETJOBS > 
site name > filename.FAM (see the example file below).
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To import, copy the .FAM file into the destination job directory, click on File, and select Import.  The 
imported messages are placed into the message numbers specified in the export file, with their 
corresponding labels and contents.

• Message numbers: - numbers of messages 1 to 511 should NOT be edited
- a message number must be unique; be careful when copying messages 

never to duplicate a message number
• Message labels: - all message labels are editable
• Message contents: - all message contents are editable

Using the Action Message Editor (continued)
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About this Option When you click on Hardware Config from the Configure menu, a screen similar to the one shown in 
Figure 3-16 is displayed.

 Figure 3-16    Hardware Configuration Window

The Hardware Configuration Window allows you to:
• Add hardware to the system
• Modify the hardware in the system
• Delete hardware from the system.

Adding Hardware 
to the System

To add hardware to the system, click on the Add button and the Add Run-Time Hardware Window 
(Figure 3-17) is displayed.

 Figure 3-17    Add Run-Time Hardware Window

At this window, click on the item you wish to add and it is highlighted.  

Configuring System Hardware
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Note: Even though they are in the list, the following hardware components are no longer supported:

•  Serial DACT

•  X.25 Interface Card

•  5 1/4” Floppy Drive

•  Mouse

After the desired item is highlighted, click on the Add button and the item is added.  You can also 
double-click on an item to add it.  If the added item requires configuration, a dialog box is presented 
that allows you to configure the added item. For details, see Appendix A - Hardware Components.

Modifying the 
Hardware in the 
System

To modify the hardware in the system, double-click on the item in the Hardware Configuration 
Window.  After you double-click on the item, a dialog box is presented that allows you to modify the 
configuration of the selected item. .

If you attempt to modify hardware that cannot be modified, a dialog box similar to the one shown in 
Figure 3-18 is displayed.

 Figure 3-18    No Configurable Information Dialog Box

This dialog box informs you that there is no configurable information for this particular hardware.  At 
this point, click on OK and you are returned to the Hardware Configuration Window.

Deleting Hardware 
from the System

To delete hardware from the system, highlight the desired item and click on the Delete button. The 
selected item is deleted unless the action conflicts with previous hardware configurations or is 
otherwise prohibited.  If you attempt to delete hardware that cannot be deleted, a dialog box similar to 
the one shown in Figure 3-19 is displayed.

 Figure 3-19    Default Hardware Dialog Box

This dialog box informs you that the hardware selected is default hardware and that it cannot be 
deleted.  At this point, click on OK and you are returned to the Hardware Configuration Window.

Note: When you delete a network card, all external points from all nodes on the associated network 
are deleted from the point database.
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Multiple Networks The TSW is capable of annunciating points from multiple networks.  Having multiple networks 
means that there are multiple .DBNs for the same customer site.  This means that more than one 4120 
.DBN file can exist in the same Network (Site) Directory.  Therefore, the TSW subdirectories within 
the Network Directory are no longer necessarily associated with a single .DBN.  Also, 4100 
subdirectories within the same Network Directory no longer necessarily contain nodes belonging to 
the same network.  If viewed as a file directory from DOS or Windows, this arrangement may appear 
confusing.  However, all 4120 Network Programming Tools present this structure to the application 
programmer organized by Customer Site, Network, and Node.

A network customer site continues to be identified with "Network" (or N) for the Job Type portion of 
the directory name and the first .DBN file created within the directory takes on the same name.  
Additional .DBN files within the directory are still identified as a "Network" Job Type but the other 
numbers composing the name do not match the original network directory name.  This approach 
allows existing single-network customer sites to retain their original names.  This also allows new 
single-network sites to be created as they have been in the past.

Note: Additional networks must be created with the Network Programmer before you add the 
network cards.

Hardware 
Configuration

A network interface card is automatically inserted into the database when the Configurator creates a 
new TSW node.  You must configure the usual network card parameters (such as, PC I/O Base 
Address, PC Interrupt Number, Network Loop Style, Network media, etc.) by editing the card from 
the Network Interface Card Configuration dialog box within the Hardware Configuration Editor.

External Points You can map external points to the TSW node from nodes on attached networks.  The general flow of 
user operation is no different for multi-net versus a single network system.  You are still required to 
add external points from one node at a time.  Nodes having the same logical node numbers are differ-
entiated by a new Network Number column as shown in Figure 3-20.

 Figure 3-20    New Network Number Column

Valid Network Numbers range from 1 to 4.
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Public Points If you make a local TSW point public from the Point Configuration Editor, it makes the point 
available to all nodes on all currently assigned networks.  When you save the TSW .DBF file, the 
appropriate .DBN files are updated to contain this public point.  If you restore a public point to its 
original local state the .DBN files are updated when the TSW .DBF file is saved.

Logical Node 
Number

Node numbers are restricted to the range of 1 to 99.  Nodes are numbered when you create them.  
Multiple network systems having more than 99 nodes necessarily have identical logical node 
numbers across networks.

Point 
Representation

Since it is possible that there are as many as four identically numbered nodes across networks, the 
Point Configuration Editor displays a point using a new Point Name format.  The new Point Name 
format is:

<network number> .  <node number> : <zone name>.

Where "node number" means "Logical Node Number of the owner node" on the network specified by 
"network number".  Thus, "1.1:ZN1" and "2.1:ZN1" appear to the operator as two distinguishable 
points.
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Logging Events When you click on Port Vectoring from the Configure menu, a screen is displayed that is similar to 
the one shown in Figure 3-21.

 Figure 3-21    Port/Event Configuration Window

At this screen, you can enable the logging of various events to selected ports.  A port is an output or 
storage device (historical log, monitor, printer, etc.).  Select a port by clicking on it.  When you click 
on a port it is highlighted.  The highlighted port is the selected port.  Select the events you want 
logged by clicking in the box that precedes the desired events.  When an X appears in the box, the 
event is selected.

By default, Alarm, Trouble, Supervisory, and Priority 2 must be selected for Monitor Ports.

Port/Event Vectoring
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Configuring Audio 
Options

When you click on Audio Options from the Configure menu, a screen similar to the one shown in 
Figure 3-22 is displayed.

 Figure 3-22    Audio Options Window

The Audio Options Window allows you to select the type of audio operation needed for the particular 
job (None, Standard, or Canadian).

Configuring Audio 
Screens

When you click on Audio Screens from the Configure menu, two choices are displayed (Speaker and 
Auxiliary).  The audio screens are used to define the audio screens that appear during runtime.  The 
speaker control screen is entered when the operator selects Audio Control from the runtime.  This 
screen should contain speaker points that the operator may want to control and buttons for turning the 
speakers on to the appropriate channels.

The auxiliary audio control screen is programmed in the same manner as the speaker control screen.  
When you click on Speaker or Auxiliary, the screen shown in Figure 3-23 is displayed.

 Figure 3-23    Control Screen Editor

Configuring Audio Options/Audio Screens
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From this screen you can choose to add or delete audio screen rows.  If you enter a number of rows to 
add and then click on OK, a screen similar to the one shown in Figure 3-24 is displayed.

 Figure 3-24    Control Screen Editor (Ready for Configuring Rows)

At this screen, you can configure the different rows that you want to appear in the audio screen, and 
assign them different actions.  Double click on the desired row in the Mode field and a screen similar 
to the one shown in Figure 3-25 is displayed.

 Figure 3-25    Point Selection Screen

From this screen you select the programming mode.  Clicking on the mode list box will display the 
possible selections for the mode.  If a mode type other than CUSTOM is selected, the rest of the fields 
in the row are automatically filled in.  If a point is applicable for the selected mode type, a point data 
entry field will appear.  To select a point for the mode type, double click in the data entry field to 
bring up the tag list or type in the point directly.  An invalid point type warning bow will appear if a 
non-applicable point is chosen for a particular mode. Figure 3-26 shows the selection window.

Configuring Audio Options/Audio Screens (continued)
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 Figure 3-26    Selection Window

Using the Control 
Screen Menu

When you click on Utility Screens from the Configure menu, a screen similar to the one shown in 
Figure 3-27 is displayed.

 Figure 3-27    Control Screen Menu

Defining Utility Control Screens
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The Control Screen Menu is used to define the utility control screens that are displayed at runtime.  
Utility control screens are used for controlling functions such as, fan control, lighting control, etc.  
Use the Control Screen Menu to:

• Open existing utility control screens
• Create new utility control screens
• Delete existing utility control screens
• Relabel existing utility control screens.

When you click on Open, the Control Screen Editor (with the Add Rows Box open) is displayed.

 Figure 3-28    Control Screen Editor (with Add Rows Box Displayed)

At this screen, enter the number of rows you want to add and click on OK. This is the number of rows 
that you want to appear on the utility screen.

After you click on OK, the Control Screen Editor, ready for configuring the added rows is displayed.

Defining Utility Control Screens (continued)
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 Figure 3-29    Control Screen Editor 
(with Rows Ready for Configuration)

At this screen, you can define the buttons and actions associated with the added rows.

The following sections provide information about using the Control Screen Editor to configure these 
rows.

Defining Utility Control Screens (continued)
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Adding a Row When you double-click in the Mode or Point column, the Hi Level Mode/Point Box is displayed.  
This allows you to select the programming mode for the row.

 Figure 3-30    Hi Level Mode/Point Window

Clicking on the mode list box will display the possible selections for the mode.  If a mode type other 
than CUSTOM is selected, the rest of the fields in the row are automatically filled in.  If a point is 
applicable for the selected mode type, a point data entry field will appear.  To select a point for the 
mode type, double click in the data entry field to bring up the tag list or type in the point directly.  An 
invalid point type warning bow will appear if a non-applicable point is chosen for a particular mode.

 Figure 3-31    Hi Level Mode/Point Window 
(Showing a List of Available Modes)

Using the Control Screen Editor
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Labeling the Row When you double-click in the Label column, the Row Label Box (Figure 3-32) is displayed.

 Figure 3-32    Row Label Box

At this screen, you can enter a Row Label.  If you click on Choose Pt, a list of points is displayed that 
you can choose from.

BTN (Button) 
Window

When you double-click in one of the BTN columns, a Button Window similar to the one shown in 
Figure 3-33 is displayed.

 Figure 3-33    Button Window

From this window, you can configure a button to operate as needed.

Adding a Screen When you click on New, the Section Label Window shown in Figure 3-34 is displayed.  This allows 
you to define the label of the utility screen being added.

 Figure 3-34    Section Label Window

After you enter a label and click on OK, the Control Screen Editor, with the Add Rows Box open, is 
displayed.  At the Add Rows Box you can enter the number of rows you want.  After entering the 
number of rows, click on OK and a screen similar to the one shown in Figure 3-29 is displayed.  At 
this screen, you can configure the rows added.

Using the Control Screen Editor (continued)
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To delete a screen, highlight the screen you want to delete and then click on Delete and the screen is 
deleted.

When you click on Relabel, the Section Label Window is again shown, this time with the Label you 
selected to change displayed.  You can re-label this item as needed.

Control Windows At runtime, when a user selects the Control Windows option from the View menu and is in the 
Utility sub-tab of the Control Windows dialog, a drop down list box of the available utility screens 
can be seen at the top left corner. The user can select the appropriate utility screen and this screen will 
appear, as illustrated in Figure 3-35.

 Figure 3-35    Runtime Control Windows Selection

When you have finished programming the Utility Screens, save them and then click on Exit and you 
are returned to the Control Screen Menu.

Using the Control Screen Editor (continued)
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Viewing the System 
Options

When you click on System Options from the Configure menu, the Preferences Option and the 
Operations Option are displayed as shown in Figure 3-36.

 Figure 3-36    Preferences and Operations Options

System Options
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Preferences 
Options

When you click on the Preferences option, a screen similar to the one shown in Figure 3-37 is 
displayed.

 Figure 3-37    System Preferences Window

Click on the box in front of the options you want activated.  When an X is displayed in the box the 
option is selected.  After you have selected all the options you want, click on OK and the options are 
activated. The following descriptions provide information about some of the system preferences.  

Auto Jump If this box is checked, then the Runtime System will be in automatic jump mode.  When the system is 
in automatic jump mode, the current activity is canceled when an event comes in and the program 
jumps to the highest priority active list or graphics screen if one is available.

Auto ACK If this box is checked, then the Runtime System will be in automatic acknowledge mode.  When the 
system is in automatic acknowledge mode, an event will cause the acknowledge box for the event to 
come up.

Beep For UnACKed 
Points

When this box is checked the Runtime System will beep as long as there are unacknowledged points 
in the system.

Always Display 
Run-Time Header

When this box is checked, the Runtime System will always display the Runtime header.  If the box is 
not checked, certain Runtime screens, such as audio and utility screens, will cover the Runtime 
header.

Beep on Button 
Press

When this box is checked, the Runtime System will beep when buttons are pressed.  This is done to 
provide feedback to the operator.  This is generally more important with the touchscreen.  This button 
is checked by default for NPU jobs, but not for TSW jobs.

System Options - Preferences
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Close Window on 
ACK

When this box is checked, the Runtime System will automatically close the acknowledge box for an 
event when that event is acknowledged.  Normally the operator must close the acknowledge box 
manually by hitting the Close Window button after reading the displayed Action Message in the 
Acknowledge dialog box.

24 Hour Time 
Format

If checked, the Runtime System will display time in 24-hour format. Otherwise, time is in 12-hour 
format.

Header always goto 
Active List

When this box is checked, the Runtime System will cause the pressing of the header button to always 
go to the Active List instead of a graphics screen.

Double click shows 
action msg

When this box is checked, the Runtime System will bring up the action message for the current state 
of the point when it is double clicked on. Normally the Point Status Display dialog box will come up 
when a point is double clicked on.

Quiet PC on first 
acknowledge

When this box is checked, the Runtime System will quiet the PC for 5 minutes on the first 
acknowledge or until a new event comes in.

Flash normal if ALL 
UnAck normal

When this box is checked, the Runtime System will flash the normal state color for the active list 
header button if ALL the unacked points on that particular active list are in the normal state. If at least 
1 abnormal unacked point exists on the active list, the header button will flash the abnormal state 
color for that active list. This option should only be used with individual acknowledge.

Reverse Active List 
Display

When this box is checked, the Runtime System will display points in the active list in reverse order, 
from newest to oldest, showing the most recent ones at the top. Normally, the active list displays 
points from oldest to newest, showing the oldest ones at the top.

Captive Mode 
Supported

When this box is checked the Runtime System will run in captive mode, unless the specific logged in 
user’s profile is set to non-captive mode. When the box is not checked, the Runtime System operates 
in non-captive mode. By default, this box is checked.

Inactivity Timeout When this box is checked, the Runtime System will log off automatically when no mouse or keyboard 
action has been made in the Runtime System for the number of minutes specified. The job must be 
built in the Runtime System before the new value is enabled.

The default value is 30 minutes; this value can be changed to any number of minutes between 1 and 
1092; however, for a particular job to be UL-approved, inactivity timeout must not exceed 30 
minutes.

A warning message will be displayed if you were working in non-captive mode when the inactivity 
timeout value occurred. This is a reminder that other applications might be running concurrently to 
the TSW.

System Options - Preferences (continued)
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Operations Option When you click on the Operations Option, a screen similar to the one shown in Figure 3-38 is 
displayed.

 Figure 3-38    System Operations Window

At this window, click on the box in front of the system operation you want activated.  When an X is 
displayed in the box the operation is selected.  Also click on the ACK Option you want activated.  
After you have made all of the selections you want, click on OK and the selections are activated. The 
following descriptions provide information about some of the system operations.

System Reset 
Inhibit

If checked, this option enables the system reset inhibit feature, allowing the user to select the system 
reset inhibit delay. This feature blocks the user from performing a system reset operation (from the 
active list display) for the duration of the specified delay following the triggering of a new event. That 
is, the user is not allowed to perform a system reset if a new point event comes in, for the duration 
specified. After that duration, a system reset operation is allowed.

Alarm Silence 
Inhibit

If checked, this option enables the alarm silence inhibit feature, allowing the user to select the alarm 
silence inhibit delay. This feature blocks the user from performing an alarm silence operation (from 
the active list display) for the duration of the specified delay following the triggering of a new event. 
That is, the user is not allowed to perform an alarm silence if a new point event comes in, for the 
duration specified. After that duration, an alarm silence operation is allowed.

Enable Network 
Reset

If this box is checked, then the operator will be able to perform a system-wide reset.  System-wide 
reset causes all latched fire/priority 2 points that are now normal to be cleared on all nodes. Two other 
steps are needed to use the feature.  These steps are:

• Fill the L0 list with all the other nodes' P212 pseudos (fire reset)
• Fill the L2 list with all the other nodes' P220 pseudos (pri2 reset).  

Note: This is a one-step reset, so that any failure during the detector reset phase will mean that the system 
reset phase will not occur.

System Options - Operations
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Enable Network 
Alarm Silence

If this box is checked, then the operator will be able to silence the alarm signals on all nodes.  Two 
other steps are needed to use the System-wide Alarm Silence feature.  These steps are:

• Fill the L1 list with all the other nodes' P217 pseudos
• Fill the L3 list with all the other nodes' P204 pseudos (to support "Alarm Silenced" indicator 

on the status line).  

Master Timekeeper If this box is checked, it indicates that this node is the master timekeeper for the network.  There can 
only be one master timekeeper per network, so if another node has already been selected as the master 
timekeeper, then this box is disabled.  If the TSW is annunciating a multi-network configuration, the 
TSW that is common to the multiple networks should be made the Master Timekeeper.

Annunciate 
Common Troubles

Checking this box causes common troubles to be annunciated.  Clearing this box prevents common 
troubles from being annunciated.  Common Troubles are troubles such as: Node Missing, Daughter 
Card Trouble, and Service Mode.

Annunciate 
Network Troubles

Checking this box causes network troubles to be annunciated.  Clearing this box prevents network 
troubles from being annunciated.  Network Troubles are troubles such as: Network Ground and 
Style 7 Fault.

Annunciate Extra 
Node Troubles

Checking this box causes extra node troubles to be annunciated. Clearing this box prevents extra node 
troubles from being annunciated. An extra node is a node that exists on the network loop, but is not 
configured as part of the network. Enabling this feature will annunciate common troubles for these 
extra nodes, if found on the network loop. Depending on the network loop, the corresponding digital 
pseudo point for extra node troubles will be turned on, if the runtime system detects a trouble on any 
extra nodes. The digital pseudo points P8, P27, P46 and P65 are setup to annunciate these extra node 
troubles, for each of the four configurable network loops.

Fixed Common 
Trouble Offset

Checking this box causes the external common trouble points which are annunciated in the TSW 
system to be placed at fixed positions in the point list. If checked, the common trouble point for 
network 1 - node 1 will always be placed at position 301. For network 1 - node 2, the point will be 
placed at position 302. This pattern is followed up to the common trouble point for network 1 - node 
99 which will be placed at position 399. Following that, all common trouble points for networks 2, 3 
and 4 will be positioned at the reserved ranges 401-499, 501-599 and 601-699, following the same 
pattern. If unchecked, common trouble points are sequentially placed starting at position 256.

ACK Options Note that, in terms of the network, both Group ACK and Individual ACK are seen as types of 
Individual ACK, whereas Global ACK is not.  You cannot build a job if you try to mix Global ACK 
with either Individual ACK or Group ACK.
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Individual ACK If Individual ACK is selected, then each event must be acknowledged individually.  That is, pressing 
OK acknowledges the single point displayed with the message.  Individual ACK requires both 
Normal and Abnormal point transitions to be ACKed.

Group ACK If Group ACK is selected, then acknowledging an event causes the Runtime system to acknowledge 
all events in the same Active List that have the same action message as the current event. For 
example, if the first alarm displays message #1, and five other alarm events are also associated with 
message #1, pressing OK will acknowledge all six events.  Group ACK is still considered to be 
Individual ACK as far as Network ACK operation is concerned.  Group ACK requires both Normal 
and Abnormal point transitions to be ACKed.

Global ACK If Global ACK is selected, then acknowledging an event causes all events in the current Active List to 
be acknowledged.  Global ACK requires only Abnormal point transitions to be ACKed.

Special Analog 
Network 
Initialization

The Special Analog Network Initialization checkbox stops analog points from being sent over a 
network for initialization unless they are in an an abnormal state. During normal operation, it stops 
analog point value changes from being sent over a network unless the values cross a threshold as 
defined in custom control. This option should be checked on large networks to reduce network 
initialization time and network traffic.  This option should not be selected if any custom control is 
written against non-threshold value changes of points  or if current values are displayed on graphic 
screens on a TSW.

Auto-Ack 2120s 
UNKNOWN/
UNACKED Points

When Auto Ack 2120 Unknown Unacked is selected, if the TSW shows all points clear, and the 
Unknown-Unacked point is in the abnormal state, the TSW will send to the 2120 a generic Ack. The 
highest priority point (Or next in the list, in the case of all the same priority points) will be acked.  
This will continue to happen until all points on the 2120 are acked and the "Unknown-Unacked" point 
on the TSW goes to Normal.

Warning:  When this option is selected, you may not know which point is being acked on the 2120 
since the Ack sent across simply acks the next point in the list.

System Options - Operations (continued)
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Selecting Colors When you click on Color Definition from the Configure menu, the window shown in Figure 3-39 is 
displayed.

 Figure 3-39    Color Selection Window

This window allows you to select an item so that you can edit its colors that are displayed during 
runtime.  To select an item for which you want to change the color, use the arrow keys or the mouse to 
highlight that particular item and then do one of the following:

• Press F2
• Double-click on the item
• Click on the Edit button.

When you perform one of these steps, the Color Pallette Window shown in Figure 3-40 is displayed.

 Figure 3-40    Color Palette Window

When the Color Palette is displayed, the color that has been selected for the item has white dashed 
lines around it.  To select a different color, click on the desired color (it now has the dashed white 
lines around it) and click on OK.  After you click on OK, you are returned to the Color Selection 
Window and you can select a new item for color editing.  After you have completed editing the 
various runtime display colors click on OK at the Color Selection Window and the changes are 
activated.

Color Definition
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Entering Job 
Information

When you click on General Information from the Configure menu, a screen similar to the one 
shown in Figure 3-41 is displayed.

 Figure 3-41    General Information Data Entry Window

At this window, enter the desired information and click on OK.  After you click on OK, the 
information is saved.

The information entered at the General Information Data Entry Window is used mainly for 
documentation purposes and is found in various places throughout the Configurator and Runtime 
System.  The following list shows the various fields and where they are used.  Any fields that are not 
listed here appear only in the General Information report.

Node Description:

• Configurator: Status Bar
• Configurator: Job Directory
• Network Programmer: Jobs Directory
• TrueSite Workstation: About Box

Run-Time Header:

The run-time header is two lines of text (with a maximum of 40 characters each), which will be 
displayed in:

• TrueSite Workstation: Status Bar.

Comments:

• TrueSite Workstation: About Box

Node Name:

• TrueSite Workstation: About Box

General Information
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Logical Node #:

• Configurator: Status Bar
• Configurator: Job Directory
• Configurator: Report Header
• Network Programmer: Jobs Directory
• TrueSite Workstation: About Box
• TrueSite Workstation: Report Header

Background and Banner

Background images for the TSW main window and banner are provided by default; these are .BMP 
format files that are displayed at runtime. Use the Browse buttons to select specific images to 
customize the main window background and the banner.

Background for

Main window Banner

Default size 1024x1000 1024x68

Larger bitmap Is cropped to maximum size Is clipped to default size

Less wide bitmap Is centered in width Is repeated across the banner area

Less tall bitmap Is centered in height Is duplicated from top to bottom

General Information (continued)
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Making Entries to 
the Job History Log

When you click on Revision History from the Configure menu, a screen similar to the one shown in 
Figure 3-42 is displayed.

 Figure 3-42    Job Revision History Window

This window shows the revision history.  The revision history is a log of job modifications.  You can 
add information to the revision history to detail what changed from one revision to the next.

Revision History
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Assigning Access 
Levels

Each user has an assigned access level.  This access level determines what the user can and cannot 
edit.  The Configurator prevents unauthorized use of certain functions by graying out unauthorized 
menu options and by not displaying unauthorized buttons and icons.  If a user enters the Configurator 
through the run-time system, then the run-time access level is carried over into the Configurator.

There are seven operator access levels (0 - 6) and one Simplex access level (7).  Access level 0 
corresponds to a system where no operator is logged in.  All of the user access levels are editable, 
which means that Simplex can prohibit even level 6 users from various services.  Logging in at level 
7 requires knowing the passcode for user SIMPLEX and having the Simplex branch software key.

All jobs are sent to the customer with at least one level 6 user already set up.

Users can only add, delete, or edit users that have an access level lower than their own access level.  
For example, a level 5 user can only add, delete, or edit users at level 4 or lower.  In addition, if a user 
is editing user authorization information he can only raise that user's access level to 1 less than his 
own.  For example, a level 4 user can only raise a user at a lower access level up to access level 3.

A user who is editing the access levels can only edit lower access levels.  For example, a user at level 
4 can only edit access levels 1, 2, and 3.  In addition he can only grant access that he has himself.  So 
the level 4 user can modify access level 3, but if he doesn't have authority to edit point configuration 
for example, then he cannot give the level 3 user access to edit point configuration.

When you click on Access Level from the Configure menu, the Runtime Access Levels Option and 
the Configurator Access Levels Option are displayed as shown in Figure 3-43.

 Figure 3-43    Runtime and Configurator Access Levels Options

Setting Up Access Levels
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Using the Runtime 
Access Level 
Editor

When you click on the Runtime Access Levels Option, a screen similar to the one shown in Figure 3-
44 is displayed.

 Figure 3-44    Runtime Access Level Editor

At this window, you can edit the runtime access levels to any of the displayed category names.  To 
edit the access level for a category, use the arrow keys or the mouse to highlight the desired category 
and click on Edit.  After you click on Edit, a screen similar to the one shown in Figure 3-45 is 
displayed.

 Figure 3-45    Typical Runtime Access Level Editing Window

At this screen, you set the access levels for being able to use various functions (editing, setting time 
and date, viewing active lists, etc.) by entering an X in the boxes for the desired access levels (0-7).  
When there is an X in a box under a particular access level, that level has access to the particular 
function.

To enter an X, click on a blank box.  To remove an X, click on a box that already has an X in it and the 
X is removed.  After you have set the access levels click on OK and the selected access levels are 
activated.

If you selected the auto-fill function, all higher access levels are automatically granted access when 
you set a particular access level.  When you deny access at a particular level all lower levels are 
automatically denied access. If you did not select the auto-fill function, you can specify individual 
access levels without regard to any adjacent levels. 

Setting Up Access Levels - Runtime Access Level
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The Edit Application Preferences allows setting of user interface preferences.

 Figure 3-46    Runtime User Interface Preferences

• Moving Toolbars and Windows: sets the access level required to allow repositioning of TSW 
toolbars and windows

• Change Application Mode: sets the access level required to allow changing the application 
mode

• UI Preferences: sets the access level required to allow changing user interface preferences

Setting Up Access Levels - Runtime Access Level (continued)



3-42

Using the 
Configurator 
Access Level 
Editor

When you click on the Configurator Access Levels Option, a screen similar to the one shown in 
Figure 3-47 is displayed.

 Figure 3-47    Configurator Access Level Editor

At this window, you can edit the access levels to any of the displayed category names.  To edit the 
access level for a category, use the arrow keys or the mouse to highlight the desired category and click 
on Edit.  

After you click on Edit, a screen similar to the one shown in Figure 3-48 is displayed.

 Figure 3-48    Typical Access Level Editing Window

At this screen, you set the access levels for being able to use various functions (creating jobs, saving 
jobs, unloading jobs, etc.) by entering an X in the boxes for the desired access levels (0-7).  When 
there is an X in a box under a particular access level, that level has access to the particular function.

To enter an X, click on a blank box.  To remove an X, click on a box that already has an X in it and the 
X is removed.  After you have set the access levels click on OK and the selected access levels are 
activated.

If you selected the auto-fill function on the Configurator Access Level Editor, all higher access levels 
are automatically granted access when you set a particular access level.  When you deny access at a 
particular level all lower levels are automatically denied access.

If you did not select the auto-fill function on the Configurator Access Level Editor, you can specify 
individual access levels without regard to any adjacent levels.

Setting Up Access Levels - Configurator Access Level
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Entering Operator 
Information

When you click on Operator Definition from the Configure menu, a screen similar to the one shown 
in Figure 3-49 is displayed. 

 Figure 3-49    Operator Definition Window

At this window, you can edit operator information.  You can change the Operator Name, and the 
Operator's Access Level.  You can also delete an operator or add an operator.  

To edit operator information, select the operator, click on Edit and edit the information as desired and 
then click on OK. 

Editing Operator 
Information

Figure 3-50 shows the Edit Operator Information Window.

 Figure 3-50    Edit Operator Information Window

To add an operator, click on Add and enter the desired information and click on OK.  To delete an 
operator, click on the desired operator, click on Delete, and click on OK and the operator is deleted.

 

 

Operator Definition
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Description The registry configuration utility is a tool that allows you to apply the registry settings which are 
necessary for correct operation of specific hardware components defined in the Hardware 
Configuration screen. This applies to the 4120 network card and the UL card.  This must be done 
following major changes to the defined hardware, such as:

• Adding a network interface card
• Deleting a network interface card
• Modifying the settings for the network interface card
• Adding or deleting a UL card.

When you click on Registry Configuration from the Configure menu, a screen similar to the one 
shown in Figure 3-51 is displayed. 

 Figure 3-51    Configure 4120 Card Driver and UL Card Driver

At this window, you can click Apply to configure the hardware drivers. This will also require you to 
reboot the PC prior to operating the hardware in the TSW Runtime. Click the Cancel button if you do 
not want to apply the new driver settings.

Registry Configuration
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Chapter 4. Graphics Editor

Introduction The Graphics Editor operates in a manner similar to other available graphics packages and allows you 
to create runtime screens for use with the TSW.  These screens can be tied to real time events.  The 
screens allow you to provide a graphical representation of the points contained within the current job.

You can create runtime screens by importing AutoCAD files, by importing previously created 
graphics files, or by creating new screens using the Graphics Editor. You can create links between 
points in the database and objects on the screen.  You can also link points and objects by color, where 
different colors are displayed depending upon the state of the point.
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The Graphics Editor allows you to create runtime screens for use with the TSW. These screens can be 
tied to real time events. The screens allow you to provide a graphical representation of the points 
contained within the current job. When you click on Graphics Editor, a window similar to the one 
below is displayed.

 Figure 4-1    Graphics Editor 
Graphics screens should be programmed on the same size resolution used at runtime (by default, 
1024x768); this ensures optimal results for icon sizes, touch size parameters, zoom levels, and so on. 
You can create runtime screens by importing AutoCAD files, by importing previously created 
graphics files, or by creating new screens using the Graphics Editor. You can create links between 
points in the database and objects on the screen by color or shape (where different colors or shapes are 
displayed depending upon the state of the point). You can also travel between screens and you can 
turn control points on the network ON and OFF.

The Graphics Editor operates in a manner similar to other available graphics packages.  It allows you 
to draw, lines, rectangles, polygons, etc.  It allows you to rotate left, rotate right, flip horizontally, flip 
vertically, etc.  As previously mentioned, you can also import existing graphics and then using the 
Graphics Editor you can edit these graphics as desired.

The following sections provide more detailed information about the Graphics Editor.

Using the Graphics Editor
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Concepts and 
Conventions

The Graphics Editor is an application used to generate runtime screens for use by the Graphics 
Runtime package. The editor is invoked from the Configurator (provided that the current operator has 
the correct access level). The editor provides tools to create screens which can be tied to real time 
events. The screens provide a graphical representation of the points contained in the database. The 
editor provides a variety of screen objects that can be placed anywhere on the screen. The base screen 
objects provided by the editor include but are not limited to lines, buttons, text, shapes and colors.  
The objects placed on the screen are used to create a user interface for the end user.

The TrueSite Workstation displays the runtime screens generated by the Graphics Editor.

Documents The Graphics Editor creates and uses a basic data file: a document.  Within a document there are three 
basic objects: background objects, dynamic links and command objects.  Each of these parts are 
built from graphical objects. Details about each of these objects follows. Documents do not occupy 
the entire display area because they must allow for the system header.

Graphic Objects The basic items created and used in the Graphics system are backgrounds and dynamically linked 
objects.  Backgrounds can contain up to 256 layers of graphical objects.  Each layer can be visible, or 
invisible, enabled or disabled.  The graphical objects on each layer can also be ordered by depth.  This 
allows the objects to appear 'in front' or 'in back' of other objects on the same layer.

Background 
Objects

Background objects are graphical objects which are stand alone and do not generally change during 
runtime.  The Graphics system allows background objects to be created from AutoCAD drawing 
files, bitmaps, and other graphics formats.  Background objects can also be drawn using the Graphics 
Editor.  Background objects can be changed at edit time, but at runtime they are static.  

Dynamic Links Dynamic links are created in the graphics editor, are always tied to specific database points, and 
generally change during runtime. When a dynamic link is created it can be placed into a control class 
for use by command objects (described below). At runtime the appearance of dynamic links changes 
based on changes in the point database. They can be used to control points or to display their status.

Command Objects There is a basic difference between command objects and previously described objects which is 
important to note; command objects are graphical objects which do not generally change during 
runtime.  Command objects are used for screen navigation and class based point control. 

Using the Graphics Editor (continued)
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Object Selection The selection method for objects is slightly different between the runtime screen and the editor 
screen.  The runtime screen consists of both non-selectable and selectable objects.  Non-selectable 
objects are things such as background objects while selectable objects are things such as dynamic 
links and command buttons.  Selectable objects in the runtime are surrounded by a 'selection border'.  
Clicking or double-clicking anywhere in the border will select an object for an action.

Unlike the runtime screen, all objects are selectable in the editor.  Objects in the editor can be moved, 
resized and changed.  Because of this they appear differently on the screen.  When an object in the 
editor is selected, eight white 'grips' appear around it.  The grips indicate spots that can be used to 
resize the object.  The object can be moved by clicking and dragging anywhere inside the object.

AutoCAD blocks comprising entities that are all supported will be converted into groups; for a list of 
supported entities, see Supported DWG/DXF Entity Types later in this chapter. If the AutoCAD block 
contains one or more entities that are not supported, the block will not be converted; this type of block 
will have grey grips. It can be selected for deletion and then be replaced by a linked graphics object.

The actual actions that take place when an object is selected depend upon its context.  

User Access Level 
Support

Both the Graphics Editor and Runtime support user access level protection in varying degrees.  Once 
in the Runtime, access level is enforced in three ways: screen access, command object access, and 
point operations access.  A logged on user can only access screens allowed for that level or lower.  
Once a screen is brought up, any command objects on it that are not accessible to the logged on user 
do not appear as selectable.  Screen access level and command object access level are programmed by 
the Graphics Editor.  Point operations (such as Enable and Disable) are protected in the Runtime as 
well.  However, point access levels are programmed by the Configurator.

Using the Graphics Editor (continued)
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The following sections describe the Graphics Editor Main Menu commands.

File Menu • New:   Create a new document.
• Open:   Open an existing document.
• Save:   Save the current document.
• Save As:   Save the current document under a different name.
• Manage:   Manage the documents within the current job.
• Save Template:   Save the current template.
• Library:   Reserved for future use.
• Print:   Print the current document.
• Import:   Import file formats are .WGS, .DOC, 4190 .DAT, .SGT (Simplex Graphics Template), 

.DXF (from AutoCAD R14, 2000), .DWG (from AutoCAD R14, 2000, 2004, 2005).
• Export:   Exports .DWG format files. However, files imported in .DXF format can only be 

exported in .DXF.
• Attributes:   Set the attributes for the current document; these include Touch Size, Zoom Level, 

Extents, and so on.
• Verify:   Test current document errors.
• Layer:   Manage the layers of the current document.
• Classes:   Manage the classes available in the current document.
• Coverage Zone: Define physical zones covering series of points.
• Preferences:   Set the preferences for the editor.
• Exit:   Terminate the editing session.

View Menu • Zoom Window:   Select an area to zoom in.
• Zoom In:   Enlarge a drawing.
• Zoom Out:   Shrink the drawing.
• Whole Screen:   Zoom based on the drawing’s extents, so that the entire drawing is visible.
• Zoom Previous: Restore the previous view.
• Zoom: Zoom to a specified zoom level.

Edit Menu • Cut: Cut the selected objects to the system clipboard.
• Copy: Copy the selected objects to the system clipboard.
• Paste: Paste an object of valid type from the system clipboard to the document.
• Select All: Select all the objects on the current layer of the document.
• Modify…: Invoke the Shape Editor Dialog.
• Group: With multiple objects selected, group them to behave as one.  
• Ungroup: Break a group back into its individual components.
• Paste From…: Reserved for future use.
• Save As… Reserved for future use.

Main Menu Commands
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Tools Menu • Pointer: Switch from drawing mode to pointing mode for selecting objects. 
• Shapes Section: To draw a shape, either choose the shape style in the Tools Menu, or on the 

floating Tool Palette if it is made visible in the editor preferences dialog.  The shapes to choose 
from are as follows:

- Line
- Rectangle
- Text
- Ellipse
- Arc
- Import Bitmap (drag the bounding rectangle for the bitmap you wish to import)
- Polygon
- Rounded rectangle
- Button
- Bezier Curve
- Import Metafile (drag the bounding rectangle for the metafile you wish to import)

• Placement Section: A collection of objects have what is known as a Z-Order.  This is their order 
in the Z axis, or the order in which they are drawn.  Changing an object’s Z-Order allows it to be 
drawn on top of or behind another object.

• Order:
- Bring To Front: Bring object to the top of the Z-Order, making it the top object drawn for the 

current layer
- Bring To Back: Push current object to the bottom of the Z-Order, allowing all other objects in 

this layer to draw on top of it
- Move Up: Move the current object up one in the Z-Order
- Move Down: Move the current object down one in the Z-Order

• Rotation Selection: Objects may be rotated about the center of the bounding rectangle.  Objects 
such as rectangles and ellipses (which are based on rectangles) may be rotated by 90 degrees.  
You can rotate and flip objects in the following manner:

- Rotate Left
- Rotate Right
- Flip Horizontal
- Flip Vertical

Link To Menu • Color:   Link the current shape’s color to the state of a point.  There are three available choices 
for state linkage and the change link dialog:

- a visible check mark causes the color and the object to be displayed
- a shaded check mark causes the object to be hidden
- if the check mark is not visible, the object is not displayed

• Shape:   Link the shapes of a current group to the state of a point.
• Analog:   Reserved for future use.
• Command:   Link a command to the current button.
• Unlink:   Remove the link from the current shape or group.
• Coverage Zone: Link the selected object to one of the coverage zones (Touch Size feature must 

be enabled).

Main Menu Commands (continued)
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This is the main dialog for editing the properties of an object.  From here, you can change the size and 
position of an object, the pen and fill properties, along with other common attributes.  The following 
sections describe different aspects of the Shape Properties Editor.

 Figure 4-2    Shape Properties Editor

Shape Group This group contains a thumbnail representation of the object you are currently editing.

Color Group This group allows you to change the color of both the pen and the fill color, along with line weight, 
background hatching and edge styles.  See the descriptions that follow:
• Fill: The color of the button is the fill color for this object.  If you wish to change the color, click-

ing on the button brings up a system color dialog, allowing you to select a new color.  If the 
object does not require a fill color or style hollow is chosen, the button is disabled.

• Pen: The pen is the outline color for a shape or the color of the text for the text object.  The color 
of the button is the pen color for this object.  If you wish to change the color of the pen, clicking 
on the button brings up a system color dialog, allowing you to select a new color.

• Line: This allows you to choose the weight of the line.  Choices are thin, medium, and thick.
• Edge: This allows you to choose the style of the line.  Choices are:

- None (no line)
- Solid (______)
- Dashed (_ _ _ _ )
- Dotted (……….)
- Dash Dot (_ .  _ .  _)
- Dash Dot Dot (_ ..  _ .._)

• Hatch: If your object has a fill color, the hatch is the pattern used by the fill brush.  Choices are:
- None (solid)
- Horizontal (lines running horizontally)
- Vertical (lines running vertically)
- Forward (diagonal lines running from upper left to lower right)
- Backward (diagonal lines running from lower left to upper right)
- Crossed (lines running horizontally and vertically)
- Diagonal (diagonal lines running forward and backward)

Shape Properties Editor
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Location Group Within this group you can set the origin (X and Y) and the height and width of the bounding 
rectangle.  The units are in document extents, which are set in the attributes dialog.

Miscellaneous 
Group

• Tag ID: ID number associated with this object.
• Rotation: Angle of rotation for a group.
• Visible: If checked, the object is visible.  If it is not checked, the object is hidden.
• Permanent Color: The permanent color of this object. 
• Hollow: If checked, there is no fill color associated with this object.  If it is not checked, fill color 

will be used.
• Zoomable: When checked, this control zooms along with the drawing.

The More > > 
Button

If there is a More > > button present, it brings up the attributes dialog for that particular object type.

Shape Properties Editor (continued)
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This dialog allows the user to choose a new bitmap and turn scaling on and off.

Bitmap Group Sections within this group are:
• Load New: This button allows you to choose a new bitmap.
• Width/Height: This gives you the original width and height of the bitmap.

Scaling Options 
Group

Sections within this group are:
• Don’t Allow Scaling
• Allow Scaling

By using these options, you can allow or disallow a bitmap from being scaled to the rectangle you 
have created.

Bitmap Properties Editor
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This dialog gives the user the ability to edit the buttons’ visual properties.

 Figure 4-3    Button Properties Dialog

Bitmap When you click on this button, the system Open file dialog appears, allowing you to choose a bitmap 
for the face of the button.

Font When you click on this button, the system Font selection dialog appears, allowing you to choose the 
font name, style, size and effects for the font used by the button.

Caption You can change the text for a button within the Caption edit box.

Button Properties Editor
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This dialog allows the user to change text properties.

 Figure 4-4    Text Properties Editor

Angle When enabled, this spin button allows you to choose the angle of rotation of the text.

Font The Font button brings up the System Font Selection Dialog.  From here, you can choose the font, 
style, size, and effects for fonts installed on your system.  If you choose Auto-Fit from the 
Justification group, then size is overridden by the size of the bounding rectangle.

Text The text edit line contains the current text for this object. The following codes can be used to insert 
specific information.
• $L: the point label
• $N: the point name
• $#: the system address for the point (example: 35-45-0 for card 35, point 45, subpoint 0)
• $V: the value that triggers the alarm (depending on the device, may be temperature, smoke, AMZ 

and so on)
• $A: the % value that triggers the alarm
• $VU: for ANAMON devices, the value that triggers the AMZ ($V), along with the unit of mea-

surement ($U)
• $T: the description for the graphic file
• $I: the ID for the graphic file (internally generated)
• $S: the name for the graphic file

Justification Group • Left:  Left-justify the text within the bounding rectangle.
• Right: Right-justify the text within the bounding rectangle.
• Center:  Center the text horizontally within the bounding rectangle.
• Vertical:  Center the text vertically within the bounding rectangle.
• Auto-Fit:  Use a font size that allows the text to best fill the bounding rectangle.  This size takes 

precedence over the point size chosen from the Font Selection Dialog.

Text Properties Editor
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This dialog can be invoked by the menu item 'File/Attributes...' or from the pop-up menu invoked by 
clicking the right mouse button on the document. 

 Figure 4-5    Document Attributes

Information Group • Description: Short description of the document.
• Created On: Date it was created.
• Last Modified: Last date the document was saved.

Options Group • Initial Graphics Screen: If selected, it is the initial screen seen when graphics are started under 
runtime.  If no document in this job has initial screen set to true, then a pick list of all available 
screens is given to the user at runtime.  Only one screen may be set to initial screen.  (Also see 
Document Manager).

• Maintain Aspect Ratio: When drawing on different graphical displays, the aspect ratio between 
pixels and inches may differ.  If you created a rectangle that you wanted to be 1” by 1”, it may be 
more like a 1 ½ “ on a VGA system.  With the Maintain Aspect Ratio checked, the editor com-
pensates for this difference.  This changes the apparent size of the drawing area.  It is suggested 
to watch the coordinates of items on the right hand side of the screen.  If the aspect ratio changes, 
they may be cut off.

• Document Extents: You may create documents at different resolutions (1024x768 is default).  It 
is recommended that you use a document extent that matches the resolution that you are working 
with and expect to use at runtime.

• Background Color: Clicking on the color button displays a dialog from which you can choose 
the background color for the document. As in AutoCAD, background colors are limited to 255.

• Touch Size:  The Apply Touch Size box must be checked for the feature to be enabled; it also 
needs to be checked for the Coverage Zones feature to be available. The numeric value entered in 
the Touch Size field defines – in inches –  the minimum size at which the “touched” graphics will 
enable control selection. When the graphics is zoomed and becomes smaller that the specified 
value, controls will not be “touchable”.

• Zoom Level: Enter a numeric value representing the percentage for the zoom feature when the 
screen is loaded, either in the graphics editor or at runtime.

Required Access 
Level Group

• Autofill: Selecting a level automatically gives access to levels greater than the level you selected.
• Access Level: The access level required to view this document under the runtime.

Document Attributes Dialog
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Classes can be created and managed from this dialog. The following sections detail aspects of this 
dialog.  Other objects within this dialog are the class name list box and the assignments list box.

 Figure 4-6    Class Names Dialog

Adding a New 
Class

To add a new class, click on the Add button.  You are prompted for the name of the class.  

Deleting a Class Click on the class you wish to delete in the Class Name list box.  With the class name highlighted, 
click on the Delete button.  You are prompted if deleting is the correct action.

Renaming a Class Click on the class you wish to rename in the Class Name list box.  With the class name highlighted, 
click on the Rename button.  An input dialog appears prompting you for the new name for the class.

Class Name List 
Box

A list of all classes available in the current document.

Assignments List 
Box

Points associated with the class.

Class Names Dialog
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Importing The Import option displays a dialog box where you select the file to import. Various source formats 
can be imported (see File Menu on page 4-5). When converting from 4190 DAT files, the editor 
preserves all information in the DAT file, but it does not currently support importation of travel keys 
or other information in Easel format. Importing from 4190 DAT files causes the following mappings:
• Type 1 Status Icons: Converted to Color Links
• Type 2 Status Icons: Converted to Shape Links
• Type 3 Status Icons: Converted to Color Links
• Command Keys: Deleted
• Title: Converted to Screen Title
• Subtitle: Deleted

Imported status icons containing database point references that cannot be resolved appear on the map 
with a comment field showing the original point id. The user must then resolve the links individually.

After a file is selected, the Import dialog box displays. Below is an example of import options for a 
DXF format file; the user can specify on which layer to place the imported object or import the 
original layers in the DXF file.

 Figure 4-7    Import Options Dialog

• Scale to size of document: extents for the imported file are changed to the extents of the screen's 
attributes settings. For example, if the screen is set to 1024 x 768, the imported drawing will be 
made larger or smaller, so that it fits in that space.

• Use original DXF extents: extents for the imported file stay the same. For example, if all objects 
on a DXF file cover an area 200 x 54, the imported screen extents will not be resized, remaining 
at 200 x 54.

• Use DXF extents: the screen size is set to the size of the imported file’s extents. For example, if 
a DXF file is created at a size of 500 x 300 but objects in that file only cover an area 200 x 54, 
then the size of the screen after import will be 200 x 54.

• Use DXF limits: the screen size is set to the size of the imported file. In the last example, the new 
screen size would be 500 x 300.

• Preserve original DXF layers: all layers defined in the imported file are maintained.
• Import all layers to background: all layers defined in the imported file are combined and 

placed in the new screen, on the layer called Background.

Exporting The Export command displays a window where you can specify the location where you want to save 
the file.

You can enter a file name and select from AutoCAD .DWG and .DXF file formats.

Import and Export Dialogs
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Documents may be created in layers.  This can ease the creation of elaborate documents.  One 
suggestion is to put objects associated with different classes on their own layer.

 Figure 4-8    Layer Control Dialog

There is a list of layers within a document.  In the first column is a box representing the layer’s visual 
state.  If the box is green, the object is visible.  If the box is grayed out, the layer is hidden.

When a layer is highlighted in the list, clicking the Show or Hide button changes a layer’s visibility. 

The next column is labeled Objects.  This is the number of objects on that layer.  Third is the name of 
the layer.  

Buttons • Set: Sets the highlighted layer to the active layer.  Any objects drawn are drawn on the active 
layer.

• Add: Add a new layer.
• Show: Make the highlighted layer visible.
• Hide: Make the highlighted area hidden.
• To Back: Move the highlighted layer to the back of the screen.  All other layers will be drawn on 

top of this layer.
• To Front: Move the highlighted layer to the front of the screen.  This layer will draw on top of all 

other layers.
• Delete: Delete the highlighted layer.  You will be prompted if deleting is really the thing to do.
• Rename: Rename the highlighted layer.  You will be prompted for the new name.
• Copy: Copy the highlighted layer to a new layer.  You will be prompted for the name.
• Merge: The objects on the highlighted layer are copied to one of the other layers currently listed.  

You will be prompted for the layer you would like to merge with.  You are then prompted if you 
would like to delete the old layer.  If you choose Yes, the current layer will be deleted.  If you 
choose No, the current layer will not be deleted.

Layer Control Dialog
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A job may have more than one document.  From here we can manage the list of documents available 
for the current job.

Name/Description: 

• List:  List of all documents available for this job.
• Delete:  Delete the highlighted document.
• Check All:  Run diagnostics on all the documents.
• Set Initial:  Toggle the highlighted document as the initial screen used in the runtime.  If a docu-

ment is set as the initial screen, the name will be preceded by a * in the list of documents.
• Import:  Reserved for future use.
• Export:  Reserved for future use.
• ?:  Show help.

Manage Documents Dialog
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Show Tool Palette When toggled on, makes the floating tool palette visible.

Database If more than one database is available, you may choose the database associated with the editor.

Spacing Group • Grid On: Shows the grid.
• Snap To Grid: When dragging and sizing objects, they will jump to the nearest grid point.
• Width: Difference between grid points on the X-Axis.
• Height: Difference between grid points on the Y-Axis.

Graphics 
Document 
Templates

You can select a document as the template.  If you do, the screen is prefilled with objects from the 
template file when a new screen is created.

 Figure 4-9    Editor Preferences Window

Editor Preferences Dialog
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Direct Output If checked, when a user, during runtime, chooses this point from the graphics screen, the command 
runs directly.  If Direct Output is not checked, choosing this object at runtime highlights all objects 
that are associated with the classes chosen in the Act On list mentioned below.  Then a user may click 
on one of the highlighted objects, and the command will affect that object.

Class Scope Group • Act On: The list of classes that this command object uses.
• Don’t Act On: The list of classes not used by this object.  Act On and Don’t Act On are mutually 

exclusive and combined represent all classes associated with this document.

Command Configure Dialog
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Point Database A dynamic link links an editor object to a point in the 4120 Dynamic Link Operations point database.  
Dynamic links have the ability to change according to the state of a point.  The Graphics system 
supports two types of dynamic links: color and shape links.  They are directly analogous to status 
icons in the 2120 Color Graphics product.  They are capable of changing color and shape respectively 
based on discrete value changes.

When a symbol is placed on a MAP a dialog box appears prompting you for configuration 
information.  The information prompted for depends upon the type of the link being added.  Usually, 
you must provide point linkage information.

Note: You can now set an object as hidden for any of the available states.

Classes You can provide a class to place the link into.  Classes are logical groupings of objects.  When objects 
are added to the MAP file they can be defined as part of a class, such as 'Control Class'.  This class 
can then be referenced generically by command objects.  For example, the user may want to add some 
objects on the screen that represent lights in a building.  By placing the objects into a class called 
'Lighting Class', the user can then add a command object that acts on all items in the class.  Classes 
are not exclusive.  It is possible for an object to be a member of more than one class at a time.  The 
sections that follow describe each link type and the information that applies to it.

Dynamic Link Operations
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Command objects form the basis for programming the end user interface.  Commands can either act 
directly on a point or can be used to activate a class of objects.

To choose a command to associate with the current button, double click on the command you wish to 
use.  This places the command in the Action List.  If the command requires additional parameters, the 
Command Configure dialog appears.

You can associate a series of commands with the same button. In a series however, some commands 
cannot be followed by another command; these are:
• EXIT
• GOTO
• RETURN
• ALARM SILENCE
• ALARM ACK, PRIORITY 2 ACK, SUPERVISORY ACK, and TROUBLE ACK
• SYSTEM RESET
• INFO MESSAGE
• ZOOM IN, ZOOM OUT, and ZOOM PREVIOUS
• WHOLE SCREEN

To remove a command from the Action List, double click on the command within the Action List.  
You are prompted to see if you wish to remove the command.

 Figure 4-10    Command Link Dialog

Required Access 
Level Group

• Autofill: Selecting a level automatically gives access to levels greater than the level you selected.
• Access Level: The access level required to use this command link under the runtime.
• Action List: The command you have chosen, along with its parameters.
• Command List: List of commands to choose from.
• Attributes: Use this button to bring up the Attributes dialog for the visual attributes of the but-

ton.
• Configure: Use this button to bring up the command configure dialog for the command in the 

action list.
• Unlink: Unlink this object from the point currently associated with the object.

Command Editor
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These dialogs let you associate colors and shapes to graphic objects.

 Figure 4-11    Link To Shape Dialog

The Link To Color option affects only the color, while the Link To Shape option can associate color 
and shape to graphic objects.

Note: The Link To Shape options operates on objects that have been grouped with the Edit > Group 
command.

Point Linkage This area is used to select a point to link to this object. Type the point name in the Name field or pick 
a point from the list provided with the F2 = Pick button.  Primary Screen for this Point check box is 
if a point is activated at runtime you would be able to jump to the primary screen automatically.

Zoom Level This area defines the runtime screen zoom level when auto-jump or view points graphic occur on the 
linked object.

Required Access 
Level Group

• Autofill: Selecting a level automatically gives access to levels greater than the level you selected.
• Access Level: The access level required to view this document under the runtime.

Link To Color and Link To Shape Dialogs
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State Linkage The list of possible states is defined here. The settings are modified by double-clicking in the 
appropriate column (see the example in Figure 4-11).

 Column 1, determines visibility
• red checkmark: the appearance of the object will change and it will be visible
• ghosted checkmark: the object will not be visible
• no checkmark: the appearance of the object will not change

 Column 2, determines whether the state is linked to a shape change

 Column 3, determines whether the state is linked to a color change

 Column 4, determines the actual color that you can select or set from the color palette

 Column 5, determines whether the state flashes

Class Linkage The actions of an object can be even more refined by associating it with a class. By making an object 
a member of a given class, single commands can affect more than one object.  The following two lists 
represent that the current object is or is not a member of the given classes
• Is a Member of
• Is NOT a Member of

To move a class from one list to the other, double click on the class, and it jumps to the other list.

Link To Color and Link To Shape Dialogs (continued)
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Note: The Touch Size feature must be enabled (File menu, Attributes command) in order to use 
coverage zones.

Defining Coverage 
Zones

In the File menu, select Coverage Zone to display the Coverage Zones dialog.

 Figure 4-12    Coverage Zones Dialog

Click the Add button to enter the name for a new coverage zone. When first created, the coverage 
zone square is grey, indicating that the zone is not visible on the graphic; the square is green if the 
zone is visible. Select the coverage zone and click Show to make it visible. The Show All button 
makes all coverage zones visible on the graphics.

Use the Delete button to delete a selected coverage zone from the list. The Hide button makes a 
selected coverage zone invisible on the graphic while Hide All makes all the converage zones 
invisible.

Linking Points After a coverage zone has been defined, you can link it to specific points. On the graphic, draw a 
rectangle over the points to be covered and, with the rectangle selected, select the Coverage Zone 
command from the Link To menu; all linked points within the selected rectangle will belong to the 
specified coverage zone.

 Figure 4-13    Coverage Zone Link Dialog

From the Coverage Zone Link dialog, select from available coverage zones and click OK.

Points that are linked to a coverage zone are listed in the Assignments box of the Coverage Zones 
dialog (Figure 4-12).
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Coverage Zones
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Drawing Keys • Alt-A: Draw an arc
• Alt-B: Draw a bitmap
• Alt-S: Draw an ellipse
• Alt-G: Draw a polygon
• Alt-N: Draw a line
• Alt-M: Draw a metafile
• Alt-O: Draw a rounded rectangle
• Alt-P: Use pointer tool
• Alt -R: Draw a rectangle
• Alt-X: Draw text
• Alt-U: Draw a button
• Alt-Z: Draw a spline

File Control Keys • Ctl-N: Create a new document
• Ctl-O: Open an existing document
• Alt-S: Save the current document
• Ctl-A: Save the current document under a different name
• Ctl-L: Invoke layer management dialog
• Ctl-M: Invoke manage document dialog
• Ctl-I: Import a document

Editing Keys • Ctl-X: Cut to clipboard
• Ctl-C: Copy to clipboard
• Ctl-V: Paste from clipboard
• Ctl-S: Save to disk
• Shift-*: Select all objects
• Alt-Return: Invoke shape editor dialog
• Ctl-G: Group objects
• Ctl-U: Ungroup objects

Zoom and Pan 
Keys

• Ctl-Up Arrow or Ctl Mousewheel-backward: Zoom out
• Ctl-Down Arrow or Ctl Mousewheel-forward: Zoom in
• Up Arrow: Pan up
• Down Arrow: Pan down
• Right Arrow: Pan right
• Left Arrow: Pan left

Rotation Keys • <: Rotate left
• >: Rotate right
• Alt-I: Flip horizontal
• Alt-V: Flip vertical

Z-Order Keys • Ctl-F: Bring object to front
• Ctl-B: Bring object to back
• Ctl-+: Move object up in Z-Order
• Ctl-"-" (minus): Move object down in Z-Order

Graphics Key Functions
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Introduction The following sections describe the Runtime Editor Limitations.

Capacities • Maximum Number of Screens: Limited to 65535 screens (or by disk size)
• Maximum Objects per Screen: Unlimited (again, there is a practical limit, to be determined)
• Coordinate Range: +/- 32767 World Coordinate Range
• Scaling Range: 1% to 65525%
• Resolution and Colors: 16.7 million colors @ 640x480

32000 colors @ 800x600
256 colors @ 1024x768
16 colors @ 1280x1024

Directory Hierarchy 
and File Name 
Extensions

All files created by the editor and used by the runtime are identified on disk by a unique three letter 
extension. The files are arranged in a hierarchy which facilitates sharing screens across nodes in a 
network environment.

In-Use Copies vs.  
Edit Copies

The directory structure described below refers to the in-use copy of each particular file.  Each 
component subdirectory in the hierarchy contains a TEMP subdirectory.  This directory is used to 
hold the 'Edit' copy of the Graphics files.  The 'Edit' copy of the graphics files become the 'in-use' 
copy when the Build operation is performed from the Configurator.  The Graphics Editor allows the 
user to selectively edit either copy.

Runtime and Editor Limitations
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Directory and File 
Hierarchy

The sample system shown below illustrates the file and directory hierarchy used by the editor and 
runtime:

NETJOBS Network Directory

9329001A Network Name
9329001A.DBN Network DBN File

 
9327001A Network Node

9327001A.dbf Database file
9327001A.jam Action Message file
9327001A.sam Action Message file
classess.doc Graphics Class Information file
GRAPHICS Graphics directory

overview.wgs Sample Document file
library.wgs Sample Document file
campus.wgs Sample Document file
TEMP Temporary directory during editing

RUNTIME Runtime directory
9327001A.dbf Database file
9327001A.sam Action Message file
9327001A.jam Action Message file
GRAPHICS Runtime Graphics directory

overview.wgs Sample Document file
library.wgs Sample Document file
campus.wgs Sample Document file

LOG Log directory
*.log Log files

9327002A Network Node
9327002A.dbf Database file
9327002A.jam Action Message file
9327002A.sam Action Message file
classess.doc Graphics Class Information file
GRAPHICS Graphics directory

overview.wgs Sample Document file
science.wgs Sample Document file
campus.wgs Sample Document file 
TEMP Temporary directory during editing

RUNTIME Runtime directory
9327001A.dbf Database file
9327001A.sam Action Message file
9327001A.jam Action Message file
GRAPHICS Runtime Graphics directory

overview.wgs Sample Document file
library.wgs Sample Document file
campus.wgs Sample Document file

LOG Log directory
*.log Log files

Runtime and Editor Limitations (continued)



4-27

The following sections describe the Color Defaults for Dynamic Link Objects.

Monitor Status

Analog w/ Output 
Status

State Name Default State Color

ALARMACK RED

PRIORITY 2 ACK CYAN

SUPERVISORY ACK VIOLET

TROUBLE ACK YELLOW

ALARM RED

PRIORITY 2 CYAN

SUPERVISORY VIOLET

TROUBLE YELLOW

ON GREEN

NORMAL GREEN

SMOKE DAMPER OPEN GREEN

SMOKE DAMPER CLOSED YELLOW

SMOKE CONTROL FAN ON GREEN

SMOKE CONTROL FAN OFF RED

State Name Default State Color

ALARMACK RED

TROUBLE ACK YELLOW

ALARM RED

TROUBLE YELLOW

ON GREEN

SMOKE (ALL) RED

TEMP 135 RED

TEMP 117 RED

NORMAL GREEN

Color Defaults for Dynamic Link Objects
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Signal Relay 
MAPNET Status

Feedback Analog 
Pseudo Status

Digital Pseudo 
Status

State Name Default State Color

TROUBLE YELLOW

ON GREEN

OFF RED

State Name Default State Color

ON GREEN

OFF RED

State Name Default State Color

ALARMACK RED

PRIORITY 2 ACK CYAN

SUPERVISORY ACK VIOLET

TROUBLE ACK YELLOW

ALARM RED

PRIORITY 2 CYAN

SUPERVISORY VIOLET

TROUBLE YELLOW

ON GREEN

NORMAL GREEN

OPEN GREEN

CLOSED YELLOW

Color Defaults for Dynamic Link Objects (continued)
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List Pseudo Status

Graphic Output 
Status

4100 Master Slots

State Name Default State Color

ALARMACK RED

PRIORITY 2 ACK CYAN

SUPERVISORY ACK VIOLET

MTBLACK YELLOW

CTBLACK YELLOW

ALARM RED

PRIORITY 2 CYAN

SUPERVISORY VIOLET

MTBL YELLOW

CTBL YELLOW

ON GREEN

OFF RED

NORMAL GREEN

OPEN GREEN

CLOSED YELLOW

State Name Default State Color

TROUBLE ACK YELLOW

TROUBLE YELLOW

ON GREEN

OFF RED

NORMAL GREEN

State Name Default State Color

TROUBLE ACK YELLOW

TROUBLE YELLOW

NORMAL GREEN

Color Defaults for Dynamic Link Objects (continued)



4-30

Input Status

Output Status

State Name Default State Color

ON GREEN

NORMAL GREEN

State Name Default State Color

ON GREEN

OFF RED

Color Defaults for Dynamic Link Objects (continued)
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The following AutoCAD entity types are supported by the Graphics Import Utility:

• LINE
• POLYLINE
• CIRCLE
• ELLIPSE
• ARC
• SOLID
• LWPLINE
• TEXT
• MTEXT (if not rotated)
• INSERT (if all entities in the block are supported)

Supported DWG/DXF Entity Types
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Controlling the 
Look of the 
Runtime Screen

In the TSW, 100% screen zoom level means showing and centering the whole screen regardless of 
display resolution, window size, or width/height ratio. By default, the Screen Default Zoom Level for 
any screen is set to 100%, i.e. for upgraded DOC screens, imported DOC screens, imported DWG/
DXF files, and screens created in the graphics editor.

It is recommended to leave the screen default zoom level at 100% so that at the runtime, when a 
screen is loaded with the 100% screen default zoom level, it is stretched to fit the runtime window and 
therefore look the same as in the editor. 

Set Document 
Extents after DWG 
import 

After importing a DWG file into the Graphics Editor, invoke the Document Attributes dialog (File 
menu), and change the Document Extents to match the Display resolution that will be used in both the 
TSW Runtime application and Editor. e.g. change "Custom" to 1280x1024.

Controlling Icon 
Size when 
Duplicating

The icon size is associated with the document extents. To make icons the same size when copying, 
you need to set the destination screen’s document extents to the same value as for the source screen’s.

As the icon size will change when zooming in/out, you should set the screen to the appropriate zoom 
level before you start to paste icons. The zoom level can be saved with each point link via the point 
linkage dialog box. At runtime, the screen will zoom to this level for the active point when auto-jump 
occurs or when the coverage zone is selected. 

Note: When using a Legend template screen for icons for new TSW Graphic screens with 
Pan&Zoom, the legend screen document extents should match your new screens. e.g for a 
new screen with 1280x1024 extents, create/use a new legend at 1280x1024

Command Button 
Visibility

When upgrading IMS graphics screens, the Zoom-able attribute is enabled for each command button. 
To ensure that command buttons are always visible at runtime when zooming in/out,change the 
attribute to non zoom-able.

AutoCAD Drawings 
with Proxy Entities

Proxy entities should be removed from AutoCAD drawings before they are imported to the graphics 
editor.

For R14 and 2000-2002 drawings, use AutoCAD 2002 with no extension tool; for 2004-2005 
drawings, use AutoCAD 2005 with no extension tool.

In all cases, use the CTRL+A command on the drawing and paste to a new drawing. Save the new 
drawing before importing to the graphics editor.

Maintaining the 
Current Drawing 
Area

The zoom level can inadvertently change if objects are added beyond the current drawing extents.

To avoid this, start by drawing a bounding rectangle (invisible or hollow with no edge) and then draw 
all objects inside the rectangle.

Graphics Programming Tips
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Adjusting Point 
Runtime Custom 
Zoom Level for 
Coverage Zones

The default value for the Runtime Custom Zoom Level for point links is set to 25% higher than the 
Screen Default Zoom Level. For example, if the Screen Default Zoom Level is 100%, the Runtime 
Custom Zoom Level is 125%.

However, if the coverage zone feature is used and the runtime graphics window is going to be a 
smaller window than the one in the graphics editor, 125% may not be sufficient to bring up the point 
as the icon size cannot exceed the touch size. It is therefore recommended to increase the zoom level 
to a higher value in such a situation.

Follow these steps to set the appropriate Runtime Custom Zoom Level:
1. Make the graphics editor’s drawing area approximately the same size as the expected runtime 

graphics window by resizing the graphics editor to match the runtime graphics window.

2. Use the Zoom Window feature to zoom into an area designated as a Coverage Zone and check 
the zoom level by displaying the View Zoom To dialog box.
The icons for point links must exceed the touch size at this zoom level.

Note: Changing runtime font size, toolbar size, or changing to another graphics window mode 
(Fixed, Floating, Dockable), or switching to smaller size monitor could reduce the expected 
runtime graphics window size. In consequence it could affect the runtime Coverage Zone 
behavior, i.e. Runtime Custom Zoom Level is not high enough to bring in the icons when 
Coverage Zone is clicked. To avoid this problem, you should increase the Runtime Custom 
Zoom Level to allow some margin space to ensure that icons will still exceed the touch size in 
case the graphics window size becomes smaller, and test those cases at runtime if possible. 
In order to save configuration time, you should test one icon first to make sure its Runtime 
Custom Zoom level works well with different runtime settings (e.g. large font, small font, large 
toolbar, small toolbar) before proceeding with all other point links.

3. Set this zoom level as the Runtime Custom Zoom Level for all point links in the Coverage Zone. 
If you want to use the same Runtime Custom Zoom Level for all your point links so you don't 
have to change the Runtime Custom Zoom Level of each point link, you can set the Screen 
Default Zoom Level to be 25% less than this Runtime Custom Zoom Level. Because the default 
Runtime Custom Zoom Level is Screen Default Zoom Level plus 25%, the Screen Default Zoom 
Level can be set in the document attribute dialog box. For instance, if your Runtime Custom 
Zoom Level is 300%, you can set  Screen Default Zoom Level to 275. Remember to set Screen 
Default Zoom Level back to 100% after all point links are added, and if you don't want your 
Screen Default Zoom Level to be 275.

Sequence for 
Creating New 
Screens

Recommended sequence for creating new screens to achieve the best result:

1. Prepare CAD drawing according to the Screen Writing Guidelines.
2. Import CAD drawing to the Graphics Editor.
3. Change the document extents to match the windows Display resolution that will be used in both 

TSW Runtime and Editor, e.g. change "Custom" to 1280x1024.
4. Draw a bounding rectangle to define the drawing area, usually from up left comer to lower right 

comer.
5. Add Command and Travel buttons inside the bounding rectangle.
6. Enable "Touch Size" feature, define and add Coverage Zones.

Continued on next page

Graphics Programming Tips (continued)
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Sequence for 
Creating New 
Screens 
(Continued)

7. Determine the zoom level that point link icons will be pasted at. This can be done by Zooming 
Window into a Coverage Zone area, then obtain the Zoom Level at that stage. Write down this 
zoom level for reference later. Always zoom to this level before pasting icons to ensure icons are 
in the same size.

8. Copy & Paste one icon, and link it to a point. Set Runtime Custom Zoom Level to be higher than 
the zoom level it's pasted at. Test this icon with Coverage Zone at Runtime.

9. Adjust Runtime Custom Zoom Level if needed, repeat Step 8 until Runtime Coverage Zone 
works correctly with different sizes graphics window.

10. Create the rest point links with the same Runtime Custom Zoom Level. 
11. For Step 7 ~ Step 10, see "Adjusting Point runtime Custom Zoom Level for Coverage Zones" for 

more details.

Graphics Programming Tips (continued)
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Chapter 5. Using the Utility, the Log On/Off 
and the Help Options

Introduction The last three options of the main menu are the Utility menu, the Log On/Off menu, and the Help 
menu.

The Utility menu allows you to build a runtime job from the current job, check a job for errors, and 
move jobs to and from floppy disks. The Log On/Off menu allows you to log on and off the system.  
The Help menu provides information about the system.

In this Chapter Refer to the page number listed in the following table for specific information on a topic.

Topic See Page #

Introduction 5-1

Using the Utilities 5-2

Using the Log On/Off Services 5-5

Using the Help 5-6

Creating the Runtime Database 5-8
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Displaying the 
Utility Menu

Go to the menu bar at the top of the Configurator main window and click on Utility.  The menu shown 
in Figure 5-1 is displayed.

 Figure 5-1      Utility Menu

The Utility Menu allows you to:

• Build a runtime job from the current job
• Check the job for errors
• Load a job from floppy disks
• Move a job to floppy disks

The following paragraphs discuss these tasks.

Using the Utilities
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Building a Runtime 
Job

When you click on Job Builder, a runtime job is built.  If errors or warning conditions exist after the 
build, a message is displayed that informs you that errors or warnings were detected.  If the job is 
built with no errors, the message shown in Figure 5-2 is displayed, informing you of this fact.

 Figure 5-2     Configurator Message 

The SOS.INI file is an initialization file that sets system parameters.  When you build a job the 
SOS.INI file is updated to reflect any changes that were made.

When this message is displayed, click on OK and the message window is closed.  You can now exit 
the Configurator if you are finished and operate the runtime software.

Note: This function should be used only when changes have been made to a TSW.  If you make 
changes to other types of nodes the Network Build function of the Network Programmer must 
be used.

Error Checking When you click on Error Check, a window similar to the one shown in Figure 5-3 is displayed.

 Figure 5-3    Build-Time Error and Warning Lists

These lists show any errors or warning conditions that exist.  You may be able to work with a job if 
warnings exist but you must go back and correct the situation if errors exist or the job will not build.

Using the Utilities (continued)
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Load from Floppy When you click on Load From Floppy, a dialog similar to the one shown in Figure 5-4 is displayed.  
The Load From Floppy function is used to load a TSW job only (not the entire network) that was 
created on another PC onto the PC where the job will be running.

 Figure 5-4    Install Job Disks Window

When this window is displayed, insert the floppy disk with the job on it and select the appropriate 
floppy disk drive (Drive A or Drive B) and click on Start.  After you click on Start, the job starts to 
install from the floppy disks.  After the job installs it becomes the current job.

Make Floppies When you click on Make Floppies, a dialog similar to the one shown in Figure 5-5 is displayed.  The 
Make Floppies function is used to transport TSW jobs only (not the entire network) from the PC on 
which they were configured to the PC on which they will run.  The PC on which the job will run reads 
in the job using the Load From Floppy function.

 Figure 5-5    Make Job Disks Window

When this window is displayed, insert a floppy disk in the floppy disk drive and select the appropriate 
floppy disk drive (Drive A or Drive B) and click on Start.  After you click on Start, the Job Files are 
copied to the floppy disks.

Using the Utilities (continued)
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When you click on Log On/Off, the Log On Services window is displayed.

 Figure 5-6    Log On Services Window

At this window, you can log off or log on again.  You can log on at a different level or at the same 
level.  To log off, click on Log Off and you are immediately logged off.

Changing the 
Default Passcode

When an operator is logging on for the first time, the passcode is a three digit number formed with his 
operator number. If the operator number has less than 3 digits, use preceding zeroes. For example, 
default passcode for Operator # 9 would be 009 and default passcode for Operator # 39 would be 039.  
After clicking OK, the Change Default Passcode Window is displayed.

 Figure 5-7    Change Default Passcode Window

Enter the new passcode.

Using the Log On/Off Services
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Displaying the Help 
Menu

When you click on Help, the window shown in Figure 5-8 is displayed.

 Figure 5-8    Help Menu

Displaying 
Configurator 
Version 
Information

When you click on About, a window similar to the one shown in Figure 5-9 is displayed.

 Figure 5-9    About Box

This window displays information about the program you are running.  This particular window shows 
that you are currently running the Configurator.

Using the Help
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Displaying the Help 
Window

When you click on Contents, a window similar to the one shown in Figure 5-10 is displayed.

 Figure 5-10    Help Window

At the Help Window you can scroll up and down to view the information contained in this window.  
You can also click on Contents to view additional information contained in the help files.

Using the Help (continued)
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How to Create the 
Runtime Database

When you have finished configuring the TSW, and the job is ready for Run Time, you must create a 
runtime database.  To create a runtime database, select the Job Builder function that is located on the 
Utility Menu.  When you click on Job Builder, the job is built and the database is created.  The TSW 
is then configured and you can operate the TSW Runtime.

Note: This function applies to the TSW.  If you change a point outside of a TSW, you must use the 
Network Programmer's Network Build function.

Creating the Runtime Database
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Appendix A - Hardware Components

Hard Disk Drive • default component; cannot be 
deleted

• one (1) hard disk per system
• in the Hardware Configuration win-

dow, double-click on HARDDSK to 
display or modify type

3 1/2” Floppy Disk 
Drive

• default component; cannot be deleted or modified
• one (1) floppy disk drive per system

Monitor • default component; cannot be 
deleted

• one (1) monitor per system
• other sizes are supported; select the 

size closer to the one actually 
installed

• in the Hardware Configuration win-
dow, double-click on MONITOR to 
display or modify type

Historical Log • default component; cannot be deleted
• one (1) historical log per system
• specify between two (2) and ten (10) volumes
• a larger site provides support for more entries
• when the historical log has used up all volumes 

sequentially, it will start again at volume 1, 
overwriting the previous data; a message warns 
you when the last volume is reached

• in the Hardware Configuration window, dou-
ble-click on HISTLOG  to display or modify 
number of volumes and volume size
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Printer • optional 
component

• there is a 
maximum 
of three (3) 
printers per 
system

• in the Add 
Runtime 
Hardware 
window, 
select the 
Printer 
option

Network Interface 
Card

• optional component
• the network must be 

created in the Net-
work Programmer in 
order to be available 
for selection in the 
Configurator

• when you configure 
the TSW for multi-
network annuncia-
tion, the network card 
must be assigned to a 
specific network; if 
there is only one net-
work, this setting is 
made by default

• there is a maximum 
of four (4) network interface cards per system

• in the Add Runtime Hardware window, select the Network Interface Card option
• select the loop style and the network; it is recommended to use the other default settings
• see Appendix B - Configuring a Network Interface Card

Hardware Components (continued)
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Network Repeater 
Card

• optional component
• there must be at least one 

(1)  network interface 
card configured before 
adding a repeater card

• there is a maximum of 
three (3) network repeater 
cards

• in the Add Runtime Hard-
ware window, select the 
Network Repeater Card 
option

• select the loop style; it is 
recommended to use the 
other default settings

UL Card • optional component

• there is a maximum of 
one (1) UL card per sys-
tem

• in the Add Runtime 
Hardware window, select 
the UL Card option

• it is recommended to use 
the default settings

Serial DACT • obsolete component; cannot be installed

X.25 Interface Card • obsolete component; cannot be installed

Alert Central • optional component
• there is a maximum of two (2) alert centrals per system
• in the Add Runtime Hardware window, select the Alert Central option

Hardware Components (continued)
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Quad Serial Port 
Card 

• optional component
• there is a maximum of one (1) quad serial port card per system; 

however, 2 cards can be physically installed (COM10 not func-
tional)

• in the Add Runtime Hardware window, select the Quad Serial 
Port Card option

• see Appendix C - Configuring a Quad Serial Port Card

Generic Port • optional component
• used in communicating with third party systems
• in the Add Runtime Hardware window, select the Generic Port 

option

5 1/4” Floppy Disk 
Drive

• obsolete component; cannot be installed

Mouse • obsolete component; cannot be installed

Time Sync Port
• optional component
• there is a maximum of one (1) time sync port per system
• in the Add Runtime Hardware window, select the Time 

Sync Port option

Hardware Components (continued)
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DACR Port • optional component
• one (1) DACR port per system
• must be on the first configured COM port
• in the Add Runtime Hardware window, select the DACR 

Port option
• it is recommended not to modify the default settings

Hardware Components (continued)
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Appendix B - Configuring a Network Interface Card 

Introduction The TSW master node can have up to four (4) network interface cards.

Making the TSW 
the Multi-Loop 
Annunciator

The Configurator can assign a single TSW node to multiple networks. To assign a single node to 
multiple networks, do the following:

1. While in the Configurator, select Configure.
2. At the Configure Menu, select Hardware Config. The Hardware Configuration Screen is dis-

played.

 B-1    Hardware Configuration Screen

3. At the Hardware Configuration Screen, add a network card. When you add the network card, the 
Network Interface Card Configuration Screen is displayed.
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 B-2    Network Interface Card Configuration Screen

4. At the Network Interface Card Configuration Screen, select which network loop this card will be 
part of as shown in the Network Directory Screen.

 B-3    Network Directory Screen

Configuring the 
Network Interface 
Cards

This section describes how to include the Network Interface Card as part of your Configurator 
hardware configuration.

Complete the following steps to configure each card:

1. Use the Up and Down arrow keys to select the Network Interface card, then select OK.
2. Use the defaults for all Base Addresses, Interrupts, and Network loop styles for each card if 

you are using the standard platform.
3. Select the Network media (either RS-485 or Fiber for each card).
4. Attach the network card to a network as follows:

A- Select the network, then enter the .DBN name, Network Name and Network Number. 
B- If there is only one .DBN file in the site directory, the system automatically assigns the net-
work card to that network.

5. Complete Steps 1 through 4 for each network card you are installing.

Configuring a Network Interface Card (continued)
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Configuring a Network Interface Card (continued)

Mapping External 
Points to the TSW 
Node

This section explains how to map external points to the TSW node from nodes on “attached” 
networks.

You can map external points to the TSW node from nodes on “attached” networks. Add external 
points from one node at a time. The External Nodes Selection dialog shows all available nodes. Nodes 
having the same Logical Node Numbers are differentiated by a new Network Number column in the 
dialog. (See figure below)

As shown in the figure below, a column is reserved for the Network Number. This number helps to 
uniquely identify nodes having the same Logical Node Number.

1. When adding external points in the Point Configuration screen, select External from the Select 
Category dialog. The system displays all available nodes as shown in the following figure.

 B-4    External Node Selection Screen

2. Use the Up and Down arrow keys to highlight the node you wish to map, then choose the Select 
button at the bottom of the screen. 

3. Add all of the points you wish to map from one node before adding points from another node.
The following table describes the fields displayed on the External Nodes Selection screen.

Field Description

JOB NAME The name of the job.

NETWORK Lists the network number where the node is located. Valid val-
ues are 1-4.
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Configuring a Network Interface Card (continued)

 B-5    External Nodes Selection Fields

Adding Points to a 
Network

Once the network interface cards have been assigned, you can add a new local  4100 point or local 
TSW point without affecting other nodes on the local network (or the connected networks). Local 
TSW points can be made public to all nodes on up to 4 directly connected 4120 Networks.

When adding a new public 4100 point or a public TSW point only nodes externalizing the public 
point require a rebuild and download. Public points on all nodes with up to 4 directly connected 4120 
Networks can be made visible (externalized) to the TSW.

For example, if you add a new public point to “TSW 1”, in, and make it external to “4100 1” on 
Network 1, only “TSW 1” and “4100 1” need to be rebuilt and downloaded. There is no impact to 
other nodes on Network 1 or to the other networks. This means there is no downtime and there are no 
“Version Mismatch” troubles on Networks 2, 3, and 4. But if you also mark the same point external in 
the 4100 on Network 3, then both Network 1 and 3 require rebuilding. 

Point Name Format

Because it’s possible to have up to 4 identically numbered nodes across networks, the Point 
Configuration Editor displays a point using the following Point Name format:
<network number> . <node number> : <zone name>

NODE The logical node number on that network. Valid values are 1 to 
99.
The Node Number uniquely identifies the node on a single net-
work. The Logical Node Number is not guaranteed to be unique 
across networks. For example, there can be as many as four 
Node 1’s visible to a multiple-loop TSW node.
The Logical Node Number (which is always equal to the Physi-
cal Node Number) of the common TSW node is the same on all 
four networks.
In order to differentiate points coming from multiple nodes on 
multiple networks, the TSW uses an enhanced version of the 
Point Name which includes the Network Number.
Note: The common TSW node has the same number across all 
attached networks.

TYPE Job type.

JOB TITLE Displays the Network Title and location.
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Configuring a Network Interface Card (continued)

For example, the system displays the following point names as two distinguishable points:
1.1:ZN1 and 2.1:ZN1.

Having the Network Number as part of the Point Name serves as a programming and troubleshooting 
aid, and it is particularly useful when viewing external System Points that have the same Custom 
Label and the same Logical Node Number and Zone Name. 

Creating Public Points

Making a local TSW point public from the Point Configuration Editor makes the point available to 
all nodes on all currently assigned networks. The appropriate .DBNs are updated to contain this 
public point when the TSW .DBF file is saved.

Restoring a public point to its original local state is accomplished just as it was in the past. 
Accordingly, the .DBN files are updated when the .DBF is saved.

Logical Node Number

The Logical Node Number is displayed in the Job Directory dialog box when you open a .DBF to 
edit and in the Network Interface Card Configuration dialog box in the Hardware Configuration 
Editor. To change a logical node number, select the General Information Configuration dialog.

Creating New 
Nodes for 
Additional Loops

1. Start the Network Programmer.
2. From the Job Directory Window of the New Network Loop, select Create from the Job menu. 
3. Select the family type.

Note: When creating new 4100 nodes it is important to fill out the Network Information screen in the 
Configurator correctly on all nodes so that it is part of the correct network loop.

Automatic Alarm 
Response Across 
Network Loops

The 4100 nodes on the separate network loops have to be custom programmed to provide automatic 
response. This is because the TSW product

- Does not pass along the 4100 point’s alarm state to the other network loop for a secondary 
4100 to respond to and

- Does not provide automatic control, since there is no default (nor user-programmed) custom 
control running.

To support automatic response to an alarm on a separate network loop, set up sharing between the two 
loops. The following point configurations need to be completed in the 4100s on each of the network 
loops before you can set up sharing:

- Public TSW digital pseudo points and/or list pseudo points 
- User custom control referencing the shared points

For example, when an alarm condition exists on Network 1, the “4100 1” on Network 1 can turn on a 
digital pseudo owned by “TSW 1.” The change in the TSW digital pseudo state can be sent to “4100 
2” on Network 2. The “4100 2” on Network 2 can then respond to the “TSW 1” digital pseudo by 
turning on its signals.

Note: You can manually control points on multiple networks from one TSW node by mapping the 
points to the TSW. To prevent network initialization issues, avoid making public a list that 
contains referenced external points
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Configuring a Network Interface Card (continued)

Setting the Master 
Time Keeper

When the common TSW node is not the Master Time Keeper, timestamps displayed with events 
could be a source of confusion because the current time displayed in the Active Lists and logged with 
events will vary depending upon which 4100 last sent a time update. 

We strongly recommend that you configure the shared TSW node as the Master Time Keeper.

To set the Master Time Keeper, complete the following steps:

1. From the Configurator, select Configure|System Options.
2. Select Operations.
3. Place an X in the Master Time Keeper and select OK.

Viewing Network 
Attendance 
Topology from the 
TSW

In the TSW Runtime, the Network  window lets you view the physical node connections on multiple 
networks.

To display a network view for a specific network, complete the following steps:

 B-6    Network Topology Report Screen

1. From the TSW Runtime, select the Network option from the Utilities menu.
2. Make sure the “Network Information” sub-tab is selected.
3. To select the network loop to display information about, click on the Select Loop option from the 

Network menu.
4. The Select Network Loop Dialog comes up, allowing you to select which network loop to dis-

play information about. Select the desired loop then press OK.
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Configuring a Network Interface Card (continued)

 B-7    Select Network Loop Dialog 

When you select a different network, the system closes the dialog box and refreshes the graphical 
drawing to accurately depict the chosen network. The graphical window’s title bar indicates which 
network is being viewed.

Downloading 
Networks

To select a node to download, complete the following steps:

1. Open the Network window as described in “Viewing Network Attendance Topology from the 
TSW”.

2. Select the Network Download sub-tab from the Network tab in the TSW.
3. Click on the Network Download button. The system displays the TSW Runtime’s Network 

Download Operation dialog box showing all networks stored on the system by Network and 
Node Name.

4. Select one network at a time to download. 

Displaying Channel 
Status Information

To display Channel Status information, complete the following steps:

1. Open the Network window as described in “Viewing Network Attendance Topology from the 
TSW”.

2. Select the Network Information sub-tab from the Network tab in the TSW.
3. Click on the Channel Status button. The system brings up the Channel Status Information win-

dow which lists all the channels for the current network loop, and their status.
4. Click OK to close the dialog.

Detaching a TSW 
from a Network 
Loop

This section explains how to detach a TSW from a network loop. When you select this option from 
the Configurator, the system deletes all external points from all nodes on the selected network.

To detach a loop, complete the following steps:

1. From the Configurator, select Hardware Config. The system displays the current hardware con-
figuration.
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 B-8    Detaching a Network Loop from the TSW

2. Highlight the network card.
3. Select the Delete button at the bottom of the screen. The system displays the Are you sure? mes-

sage before deleting the network.
4. Select OK to delete the network, press Cancel to cancel the deletion. After you select OK, all 

external points from nodes on that network loop are automatically deleted from the point data-
base.

Building Multi-Loop 
Networks

Build each loop individually.
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Appendix C - Configuring a Quad Serial Port Card 

Using the 
Configurator

The Configurator is where you define each port on the Quad Serial Card to the network.

Note: All required hardware and software (e.g., controllers, drivers, etc.) must be installed before 
you can successfully complete the following configuration.

1. Start the Configurator.  The system displays the Configurator screen.

 C-1    Configurator Screen

2. From the Configure menu, select the Hardware Config option.  The system displays the Hard-
ware Configuration screen.
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 C-2    Hardware Configuration

3. Check the current hardware settings.  To change a specific hardware setting, highlight the setting 
with your mouse and double click or use the Up and Down arrow keys to highlight the setting 
you wish to change and press F2.  To add hardware, click the Add button. The system displays 
the Add Run-Time Hardware selection screen.

 C-3    Add Run-Time Hardware Selection

Configuring a Quad Serial Port Card (continued)
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4. Use the mouse to highlight the Quad Serial Card option, and then click the Add button at the 
bottom of the screen to configure the card. You can configure up to 2 ports per job, using COM1 
through COM9. The system displays a dialog where you select the Base COM Port Address.

 C-4    Base COM Port Address Selection

5. Select an available COM port as the Base COM Port Address (COM1 through COM5 with 
COM3 as the recommended port).  When finished, select OK.  Select OK from the Add Run-
Time Hardware screen.  The system returns to the original Configuration screen (figure C-2) 
which now includes the Quad Serial Port Card.  

6. Select OK at the bottom of the Configuration screen.  The system will ask you if you want to 
save the new configuration.  Select OK to save, or select Cancel to cancel the configuration.

Notes: Do not attempt to assign port directories or dump files until you have saved the new hardware 
configuration.

You can have at most 2 quad serial port cards per job.

Configuring a Quad Serial Port Card (continued)
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Use the following steps to add 2120 points to the network and to the point database.

1. In Windows Explorer, go to the following directory:
\netjobs\tst2120\n7

2. Create a new folder: 2120_1 for Port 1, or 2120_2 for Port 2, etc.
3. Copy the 2120 dump file to the new directory.  The file extension must be .SLI in order for the 

4120 Programmer software to accept it.

Note: The Configurator scans the new directory for a .SLI file.  The Configurator learns this file 
name only once.  Do not change the name after the directory has been scanned.  

4. Start the Configurator. The system is now aware of the new port configurations and has automat-
ically added certain system, channel, and transponder information into the hardware configura-
tion.  

5. From the Point Configuration screen, scroll past Point No.  52815 to display the information 
added in Step 5 above.

6. To add 2120 user points, scroll to the user point range (point numbers between 2816 and 52815), 
then click the Add button at the top of the screen.  The system displays the Select Category 
screen.

 C-5    Select Category 

7. Click on the 2120 BMUX button to choose an available BMUX.  The system then shows the Port 
Selection screen.  Highlight the appropriate port number and click Select.

8. To tag a point, highlight each 2120 point and press the space bar to select each point (you can 
select all points by clicking the Tag all button at the top of the screen).  When you are finished 
making your selections, press OK.  The system displays the Port Selection screen.  

Configuring a Quad Serial Port Card (continued)
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 C-6    2120 Points Tag List Screen

9. Select the Exit button to return to the Select Category screen and select OK to return to the Point 
Configuration screen.  (Repeat Steps 6 through 8 for each 2120 BMUX in the system.)  The sys-
tem displays the new 2120 points with a LC2 as the class.  To change the class to Public, high-
light the Class field that you want to change and click the Toggle button to toggle between the 
classes.

10. At this point, you can save the database and build using the standard method.

Configuring a Quad Serial Port Card (continued)
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Appendix D - Configuring a DACR Port

Defining the DACR 
Port

The Configurator is where you define each DACR port.

Note: All required hardware and software (e.g., controllers, drivers, etc.) must be installed before 
you can successfully complete the following configuration. Detailed information can be found 
in the Simplex TrueSite Workstation Installation and Checkout Instructions (579-834).

1. Start the Configurator.  The system displays the Configurator screen.

 D-1    Configurator Screen

2. From the Configure menu, select the Hardware Config option.  The system displays the Hard-
ware Configuration screen.

 D-2    Hardware Configuration
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3. Check the current hardware settings.  To change a specific hardware setting, highlight the setting 
with your mouse and double click or use the Up and Down arrow keys to highlight the setting 
you wish to change and press F2.  The system displays the Add Run-Time Hardware selection 
screen.

 D-3    Add Run-Time Hardware Selection

4. Use the mouse to highlight the DACR Port option, and then click the Add button. The system 
displays the DACR Port configuration screen.

 D-4    DACR Port Configuration Screen

5. Select the COM port connected to the DACR and enter the information in the remaining fields 
before clicking OK.

Note: If both DACR and 2120 are in use, DACR must use a COM port. DACR should always be on 
COM1.

Configuring a DACR Port (continued)
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Adding DACR 
Accounts and 
Points

Next, you need to add accounts and points. To do so, you:

1. Select Point Configuration from the Configuration Menu.
2. Scroll to an empty point in the user area.
3. Click the Add Button.
4. Click the DACR Button.
You are then prompted with three choices: Add Event Account, Manual Point Entry, and Import CID
Points.

 D-5    Add DACR Points Dialog

Depending on what transmission communication format is being used for the panel and on what type
of information you want annunciated at the TrueSite Workstation, select the appropriate button. The
reporting protocol formats supported by the TrueSite Workstation are: Ademco CID, 3/1, 4-2, BFSK,
and SIA level 1.

Configuring a DACR Port (continued)
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Adding the Event 
Account

You need to add an event account if the panel for the account that you are configuring is a format
other than CID, or the format is CID but you don't care to annunciate events at the per point level. In
this configuration, the TrueSite Workstation will indicate a FIRE, PRI2, Supervisory, or trouble
condition at the panel but will not indicate the specific device that initiated the alarm condition.

 D-6    Add Event Account Dialog

To add an event account, do the following:
1. Enter the Account number being used by the dialing panel.
2. Enter a label indicating the location of the panel.

Entering Points 
Manually

If you want to enter a few points manually and the dialing panel is Contact ID, you must do the
following:

1. Enter the Account number being used by the dialing panel.
2. Enter a label indicating the location of the panel. (This step is only necessary the first time that 

you enter a point for this account. Subsequently, the label will be automatically filled once the 
account number is entered).

3. Enter the CID Group for the point that you are configuring.
4. Enter the CID Point number for the point that you are configuring.
5. Select the device type for how you want to annunciate this device.
6. Select the point type for how you want to annunciate this point.
7. Enter a label to identify the location of the configured point.

Configuring a DACR Port (continued)
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